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Welcome to the ST-M1000 User's Guide.
For a printable PDF copy of this guide, click here.



Product Basics

See these sections to learn about the basic features of your product.

Control Panel Buttons and Lights

Product Parts Locations

The Power Off and Sleep Timers

Epson Connect Solutions for Smartphones, Tablets, and More
Using Google Cloud Print

Setting Up Google Cloud Print on a Chromebook

Using the Mopria Print Service

Android Printing Using the Epson Print Enabler

Using Fire OS Printing

Using Windows 10 Mobile Printing

Control Panel Buttons and Lights

2RO

o
o) (>0
60
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1 O power button and light
2  #pnetwork status button
3 Wi-Fi button
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= Wi-Fi and [& Wi-Fi Direct lights
0 ink and [J paper lights
@ stop button

Parent topic: Product Basics

Related references
Product Light Status

Product Parts Locations

See these sections to identify the parts on your product.

Product Parts - Front/Inside
Product Parts - Back

Parent topic: Product Basics

Product Parts - Front/Inside

o © 60

Control panel
2 Printer cover
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Print head

Ink tank cover
Ink tank cap
Ink tank

Front cover

0 N oo o~ W

Paper cassette cover

Feeder guard

Rear paper feed slot

Rear paper edge guides
Output tray

Output selector

Paper cassette edge guides

N O oA W N -

Paper cassette

Parent topic: Product Parts Locations
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Product Parts - Back

Rear cover
LAN port
USB port
AC inlet

Maintenance box cover

a WO N -

Parent topic: Product Parts Locations

The Power Off and Sleep Timers

The product enters sleep mode or turns off automatically if it is not used for a period of time. You can
adjust the time period before power management begins, but increasing the time reduces the product's
energy efficiency.

Changing the Power Off and Sleep Timer Settings - Windows
Changing the Power Off and Sleep Timer Settings - Mac

Parent topic: Product Basics
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Changing the Power Off and Sleep Timer Settings - Windows

You can use the printer software to change the time period before the printer enters sleep mode or turns
off automatically.

1. Access the Windows Desktop and right-click the & icon for your product in the right side of the

Windows taskbar, or click the up arrow and right-click 2. Select Printer Settings and click the
Maintenance tab.

2. Click the Printer and Option Information button.
You see this window:

et e o o Syt s PN S v b
L= (o | [ =
3. Select the time period you want as the Power Off Timer setting.
4. Click Send.
5. Select the time period you want as the Sleep Timer setting.
6. Click Send.
7.

Click OK to close the open program windows.
Parent topic: The Power Off and Sleep Timers

Changing the Power Off and Sleep Timer Settings - Mac

You can use the printer software to change the time period before the printer enters sleep mode or turns
off automatically.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

14



2. Select Printer Settings.
You see this screen:

EPSON
g" Printer Sattings

Power O Timer

Off

[+

Slecp Timer

13 = minutes [1 ... 240]

Cancel Apply

3. Select the time period you want as the Power Off Timer setting.

4. Select the time period you want as the Sleep Timer setting.

5. Click Apply.

6. If you see the confirmation message, click Yes, and close the Printer Settings window.
Parent topic: The Power Off and Sleep Timers

Epson Connect Solutions for Smartphones, Tablets, and More

Use your smartphone, tablet, or computer to print documents, photos, emails, and web pages from your
home, office, or even across the globe.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Using Epson Email Print

15



Using the Epson iPrint Mobile App
Using Epson Remote Print

Parent topic: Product Basics

Related tasks
Using Google Cloud Print

Related topics
Wi-Fi or Wired Networking

Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the
attachments will print automatically.

1. Connect your product to your network. See the link below.

2. If you did not already set up Email Print when you installed your product software, visit
epson.com/connect (U.S), epson.ca/connect (Canada), or epsonconnect.com (Caribbean) to learn
more about Email Print, create your Epson Connect account, and register your product to the Epson
Connect service.

3. Now you are ready to send and print emails to your product's Email Print address.

Note: Go to epsonconnect.com and log into your Epson connect account to personalize your product's
email, adjust print settings, and set up other Epson Connect services.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using the Epson iPrint Mobile App

Use this free Apple and Android app to print with networked Epson products. Epson iPrint lets you print
PDFs, Microsoft Office documents, photos, and web pages from your device or from popular cloud
services such as Box, Dropbox, Evernote, Google Drive, or Microsoft OneDrive.

1. Connect your product to your wireless network. See the link below.

2. Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean)
to learn more about Epson iPrint and check the compatibility of your mobile device.
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https://www.epson.com/connect
https://www.epson.ca/connect
https://www.epsonconnect.com
http://www.epsonconnect.com
https://www.epson.com/connect
https://www.epson.ca/connect
https://epson.com.jm/connect

3. Download Epson iPrint from the Apple App Store or Google Play.

4. Connect your mobile device to the same wireless network as your product.
5. Open Epson iPrint and select your Epson product.

Now you are ready to print with your mobile device and your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Epson Remote Print

With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson
Email-enabled product anywhere in the world.

1. Connect your Epson product to your wireless network. See the link below.

2. Ifyou did not already set up an Epson Connect account when you installed your product software,
visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address.

3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print
Driver software.

4. Download and install the Remote Print software.
5. Enter the email address and optional access key of your Epson product during Remote Print setup.

6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer
application and choose the Remote Print option for your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
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http://www.epsonconnect.com
http://www.epsonconnect.com

Note your product's IP address by checking your network status. See the link below.
Connect your computer or your mobile device to the same wireless network as your Epson product.
Enter your product's IP address into the address bar of a web browser.

L S

Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

6. Click Register.
Select the checkbox to agree to the Usage Advisory and click Next.
Click OK to launch the sign-in page.
A separate browser window opens.

9. Enter your Google Account username and password and click Sign in, or, if you don't have an
account, click Sign up for a new Google Account and follow the on-screen instructions.

10. Click Finish printer registration to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with Internet access. Visit Epson Support for Google Cloud Print
(U.S) or Epson Support for Google Cloud Print (Canada) for more information on using Google Cloud
Print, or the Google Cloud Print website for a list of supported apps.

Parent topic: Product Basics

Related tasks
Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking

Setting Up Google Cloud Print on a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

Note: See your Chromebook's documentation for details on connecting to a network.
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https://www.epson.com/Support/Printers/Mobile-and-Cloud-Solutions/Google-Cloud-Print-Support/s/SPT_GPRINT-NS
https://www.epson.ca/Support/Printers/Mobile-and-Cloud-Solutions/Google-Cloud-Print-Support/s/SPT_GPRINT-NS
http://www.google.com/cloudprint/learn/index.html
http://www.google.com/cloudprint/learn/apps.html

3. Do one of the following:

» Click Add to Cloud Print in the notification that appears in the corner of your Chromebook
screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

* Open a web browser and enter chrome://devices in the address bar. Skip to step 5.
* If you see a registration confirmation screen instead, click Register.

Click Add Device.

Click the Register button that appears next to your product.

Click Register on the confirmation screen.

N o o b

Select OK or press the OK button on your product to confirm the Google Cloud Print connection and
print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, iPhone,
or Android phone with Internet access. Visit Epson Support for Google Cloud Print (U.S) or Epson
Support for Google Cloud Print (Canada) for more information on using Google Cloud Print, or the
Google Cloud Print website for a list of supported apps.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Using the Mopria Print Service

You can use the Mopria Print Service to print from your Android phone or tablet (Android v4.4 or later) to
your Epson product or any Mopria-certified product from other manufacturers. You can download the
Mopria Print Service from Google Play.

Note: For details on the Mopria Print Service, click here (U.S) or click here (Canada).

1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Mopria Print Service app from Google Play.

Note: On some Samsung Galaxy devices, Mopria may come preinstalled.
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https://www.epson.com/Support/Printers/Mobile-and-Cloud-Solutions/Google-Cloud-Print-Support/s/SPT_GPRINT-NS
https://www.epson.ca/Support/Printers/Mobile-and-Cloud-Solutions/Google-Cloud-Print-Support/s/SPT_GPRINT-NS
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3. Go to Settings on your Android device, select Printing, and enable the Mopria Print Service, if
necessary.

4. Connect your Android device to the same wireless network as your product.

5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu

icon and select Print. Then select All printers, select your Epson product, adjust your print settings,
and print.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Android Printing Using the Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone
or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson
product and print.

1. Connect your Epson product to your wireless network. See the link below.

On your Android device, download the Epson Print Enabler plug-in from Google Play.

Go to Settings on your Android device, select Printing, and enable the Epson plug-in, if necessary.
Connect your Android device to the same wireless network as your product.

Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu
icon and print whatever is on the screen.

o K~ b

Note: If you do not see your product, tap All Printers and select your product.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Using Fire OS Printing

You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product.
There is no software to download, no drivers to install, and no cables to connect. With just a few taps in

Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson
product.

1. Connect your Epson product to your wireless network. See the link below.
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2. Connect your Amazon device to the same wireless network as your product.

3. Now you are ready to print. From your Amazon application, tap the print option and select your
product to print whatever is on the screen.

Note: If you see a message telling you that a plug-in is required, tap OK and tap Download. If your
Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria
Print Service app to print.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Using Windows 10 Mobile Printing

You can wirelessly print from Windows 10 Mobile tablets and phones to your nearby networked Epson
product. There is no software to download, no drivers to install, and no cables to connect. Look for the
print option in your Windows 10 application to send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Windows 10 Mobile device to the same wireless network as your product.

3. Now you are ready to print. From your Windows 10 application, tap the print option and select your
product to print whatever is on the screen.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking
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Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.

Network Security Recommendations

Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

Printing a Network Connection Report
Changing or Updating Network Connections

Network Security Recommendations

To help deter unauthorized access to your product over a network, you should protect your network
environment using appropriate security measures.

Security measures such as these can help deter threats such as loss of user data, use of telephone and
fax lines, and other intrusions:

* Enable security on your wireless LAN

Enable the appropriate security on the wireless LAN you plan to use with your product. Network
security such as a network password can deter interception of traffic over the wireless LAN. Your
router may already have a default password enabled by your Internet service provider (ISP). See your
ISP and router documentation for instructions on how to change the default password and better
secure your network.

» Connect your product only to a network protected by a firewall

Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead,
connect it to a router or other network connection protected by a firewall. Your router may already
have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best
results, set up and use a private IP address for your network connection.

* Change the default administrator password on your product

If your product has an option to set an administrator password, change the default administrator
password to deter access by unauthorized users to personal data stored on your product, such as IDs,
passwords, and contact lists.

Parent topic: Wi-Fi or Wired Networking
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Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without

requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network
access point for up to 8 devices.

LM (s

1 Epson product
2  Computer with a wireless interface
3  Other wireless device

Enabling Wi-Fi Direct Mode
Parent topic: Wi-Fi or Wired Networking
Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or
other devices without a wireless router or access point. Make sure paper is loaded before you begin.

Note: If you are printing from a computer, make sure you installed the network software as described on
the Start Here sheet.

1. Hold down the Wi-Fi button and press the £z network status button until the & Wi-Fi light and & Wi-

Fi Direct light flash alternately. Then release both buttons.
After both lights stop flashing, the [ Wi-Fi Direct light remains on.
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2. Hold down the %@ network status button on the product for at least five seconds to print a network
status sheet.

Note: If you release the button before five seconds has passed, a network connection report is
printed instead of a network status sheet.

3. Use your computer or wireless device to select the Wi-Fi network name (SSID) and password listed
in the Wi-Fi Direct section of the network status sheet.

Note: If you are connecting an Android device, the & Wi-Fi and [& Wi-Fi Direct lights flash
simultaneously. Do one of the following:

* Press the Wi-Fi button to connect the device.
« Press the @ stop button to cancel the connection request.

You should now be able to print to your product directly from your computer or device. If you cannot
print successfully, repeat the process above and make sure you enter the password exactly as
written on the network status sheet.

Parent topic: Wi-Fi Direct Mode Setup

Related tasks
Printing a Network Status Sheet

Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network

If you have a WPS-enabled router or access point, you can use Wi-Fi Protected Setup (WPS) to connect
your device to the network.
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Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Press the WPS button on your router or access point.

2. Hold down the Wi-Fi button on your product for about five seconds until the = Wi-Fi light and & Wi-
Fi Direct light flash alternately.

The & Wi-Fi light turns green to indicate a successful connection.

Note: Be sure to press and hold the Wi-Fi button on your product within 2 minutes of pressing the
WPS button on your router or access point.

Parent topic: Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

To print the status sheet, hold down the & network status button on the product for at least five seconds.

Note: If you release the button before five seconds elapses, a network connection report is printed
instead of a network status sheet.

Examine the settings shown on the network status sheet to diagnose any problems you may have.
Parent topic: Wi-Fi or Wired Networking

Related tasks
Printing a Network Connection Report

Printing a Network Connection Report

You can print a network connection report to view solutions to any problems you may have using your
product on a network.

To print the report, press the £ network status button on the product.

Examine the error codes and solutions shown on the network connection report.
Network Connection Report Codes and Messages

Parent topic: Wi-Fi or Wired Networking
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Network Connection Report Codes and Messages

Check the error codes and messages on the network connection report to solve problems you may
encounter with network connections. The tables here list solutions to problems based on the error codes
and messages that may appear on the top of the report.

- 4

heck Netwark Consmcticon

Check Reault FATL

Error cods [rs -1

Eme the Metwork Status aod check Lf the Metwork Nams (SSID) is
Eha SETE ySu WAAE B8 SonmBeR,
T1F tha S8I0 18 corzect, Sake #UsSe 19 GALEE LG COPrect PaEEWOTd

and try sgain.

If your problems persist,
sed your desusentatiss for halp and networking tips.

1 Error code
2  Message

Note: Error codes and messages listed here may not all apply to your product.

Error Codes and Messages

Error code and message Solution

E1 Make sure your router, access point, and/or hub are
turned on, and the network cable is securely connected to

Confirm that the network cable is .
your device and to your product.

connected and network devices such as
hub, router, or access point are turned on. |If you are trying to set up Wi-Fi, remove the network cable
and set up Wi-Fi again. Ethernet and Wi-Fi cannot be
connected at the same time.
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Error code and message

Solution

E2,E3, or E7

No wireless network names (SSID) found.
Confirm that the router/access point is
turned on and the wireless network (SSID)
is set up correctly. Contact your network
administrator for assistance.

No wireless network names (SSID) found.
Confirm that the wireless network name
(SSID) of the PC you wish to connect is set
up correctly. Contact your network
administrator for assistance.

Entered security key/password does not
match the one set for your router/access
point. Confirm security key/password.
Contact your network administrator for
assistance.

Check the following:

Make sure your router or access point is turned on, and
is correctly connected to your computer or network
device.

Turn off the router or access point, wait about 10
seconds, and turn it on again.

Move your product closer to your router or access point,
and remove any obstacles between them. Also move
your product away from devices such as wireless
phones or microwaves.

Confirm that the SSID shown on the network
connection report matches the label on your router or
access point. Also make sure your SSID uses only
ASCII characters and symbols, or your product cannot
display the SSID correctly.

If you are trying to connect using the WPS push button
method, make sure your router or access point supports
it.

If you are using a network password, check the label on
your router or access point to confirm that you are using
the correct password, or check with your network
administrator or router/access point documentation.

If you are connecting to a smart device that generates
an SSID, check the device documentation for the SSID
and password you should use.

If your wireless connection suddenly disconnects, and
another smart device was added to the network using a
WPS push button method or your network was set up
using a non-WPS push button method, try downloading
and installing your product software again.
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Error code and message

Solution

ES5

Security mode (e.g. WEP, WPA) does not
match the current setting of the printer.
Confirm security mode. Contact your
network administrator for assistance.

If the security on your router or access point is not one of
the following types, change the type of security on your
router or access point and reset your product's network
settings.

WEP-64 bit (40 bit)

WEP-128 bit (104 bit)

WPA PSK (TKIP/AES); also known as WPA Personal
WPA2 PSK (TKIP/AES); also known as WPA2 Personal
WPA (TKIP/AES)

WPA2 (TKIP/AES)

Also make sure you are connecting to the 2.4GHz band
on your network and using the password for that band.

E6

MAC address of your printer may be
filtered. Check whether your router/access
point has restrictions such as MAC address
filtering. See the documentation of the
router/access point or contact your network
administrator for assistance.

If your router or access point has MAC address filtering
enabled, register your product's MAC address so it is not
filtered. Locate the MAC address on the network
connection report and check your router or access point
documentation for instructions.

If your router or access point is using shared
authentication with WEP security, confirm that you are
using the correct authentication key and index.

If your router or access point limits the number of
connected devices, raise the connection limit. See your
router or access point documentation for instructions.

E8

Incorrect IP address is assigned to the
printer. Confirm IP address setup of the
network device (hub, router, or access
point). Contact your network administrator
for assistance.

If your product's Obtain IP Address setting is set to Auto,
enable DHCP on your router or access point. Ifitis set to
Manual, the IP address may be out of range oron a
different network segment; set a valid IP address using
your product control panel or the Web Config utility.

You can also try turning off your product and the router or
access point, waiting about 10 seconds, and turning them
on again.
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Error code and message

Solution

E9

Confirm the connection and network setup
of the PC or other device. Connection using
the EpsonNet Setup is available. Contact
your network administrator for assistance.

Make sure your computer or network device are turned
on. Also make sure that you can access the Internet and
other devices on the same network from the devices you
are trying to connect to your product.

If you still cannot connect to your product, turn off your
router or access point, wait about 10 seconds, and turn it
on again. Download and install your product software
again to reset your network settings.

E10

Confirm IP address, subnet mask, and
default gateway setup. Connection using
the EpsonNet Setup is available. Contact
your network administrator for assistance.

Make sure other devices on the network are turned on and
do the following:

If your product's Obtain IP Address setting is set to
Manual, check the IP address, subnet mask, and
default gateway addresses on the network connection
report to see if they are correct. If not, correct the
settings.

If DHCP is enabled, set your product's Obtain IP
Address setting to Auto. If you want to use the DHCP-
assigned address as a static address, set the Obtain IP
Address setting to Manual, enter the product's IP
address as listed on the network connection report, and
set the subnet mask to 255.255.255.0.

If you still cannot connect to your product, turn off your
router or access point, wait about 10 seconds, and turn it
on again.

E11

Setup is incomplete. Confirm default
gateway setup. Connection using the
EpsonNet Setup is available. Contact your
network administrator for assistance.

If you set your product's TCP/IP Setup setting to Manual,
check that the default gateway address listed on the
network connection report is correct. Also turn on the
device that is set as the default gateway.
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Error code and message Solution

E12 Make sure other devices on the network are turned on and

Confirm the following do the following:

* Make sure the IP address, subnet mask, and default
gateway addresses are correct, if you are entering them

-Index of the security key/password is setto| manually.

the first number

-Entered security key/password is correct

» Confirm that the subnet mask and default gateway
-IP address, subnet mask, or default addresses for other devices are the same.

gateway setup is correct » Make sure the IP address does not conflict with other

Contact your network administrator for devices.

assistance. If you still cannot connect to your product, do the

following:

» Turn off your router or access point, wait about 10
seconds, and turn it on again.

* Download and install your product software again to
reset your network settings.

* If your router or access point uses WEP security with
several registered passwords, make sure that the first
registered password is set on your product.

E13 Make sure your router, access point, and/or hub are
turned on. Also make sure the TCP/IP setup on your
router, access point, and/or hub is not set manually; this
-Entered security key/password is correct [ may cause your product's network settings to differ from
the manually set up devices.

Confirm the following

-Index of the security key/password is set to
the first number If you still cannot connect to your product, do the

-Connection and network setup of the PC following:

or other device is correct » Turn off your router or access point, wait about 10

Contact your network administrator for seconds, and turn it on again.

assistance. * Download and install your product software again to
reset your network settings.

* If your router or access point uses WEP security with
several registered passwords, make sure that the first
registered password is set on your product.
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Network Environment Messages

Message

Solution

The Wi-Fi environment needs to be
improved. Turn the wireless router off and
then turn it on. If the connection does not
improve, see the documentation for the
wireless router.

Move your product closer to your router or access point,
and remove any obstacles between them. Then turn off
your router or access point, wait about 10 seconds, and
turn it back on again. If you still cannot connect to your
product, check the documentation that came with your
router or access point for solutions.

*No more devices can be connected.
Disconnect one of the connected devices if
you want to add another one.

You can connect up to 8 computers or other devices to
your product using a Wi-Fi Direct (Simple AP) connection.
If you want to add another device, disconnect an existing
connected device first.

Parent topic: Printing a Network Connection Report

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility

Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection

Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

1. Print a network status sheet.

2. Locate the IP address for your product that is listed on the network status sheet.

3. On a computer or other device connected to the same network as your product, open a web

browser.

4. Enter your product's IP address into the address bar.
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You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections

Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.

3. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Related tasks
Uninstalling Printing Software - Standard Epson Printer Software - Windows
Uninstalling Product Software - Mac

Changing a Wi-Fi Connection to a Wired Network Connection

If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.

Connect one end of an Ethernet network cable to the product's LAN port.

Connect the other end to any available LAN port on your router or access point.
Uninstall your product software.

Download and install your product software from the Epson website.

Follow the on-screen instructions to install the software.

When you see the Select Your Connection screen, select Wired network connection.
If you see a Select Setup Option screen, select Set up printer for the first time.

© N Ok wDh =

Continue following the rest of the on-screen instructions.
Parent topic: Changing or Updating Network Connections

Related tasks
Uninstalling Printing Software - Standard Epson Printer Software - Windows
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Uninstalling Product Software - Mac

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation for instructions.

1. Do one of the following:
* Windows: Uninstall your product software.
* Mac: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Related tasks
Uninstalling Printing Software - Standard Epson Printer Software - Windows

Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection. You can disable the Wi-Fi features by resetting
the network settings to their default values.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use. These
settings will be reset to their default values.

1. Turn off the product.

2. Hold down the #m network status button and press the & power button until the = Wi-Fi light and
[ Wi-Fi Direct light flash alternately. Then release both buttons.

When the & Wi-Fi light and [ Wi-Fi Direct light turn off, Wi-Fi is disabled.
Parent topic: Changing or Updating Network Connections
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Loading Paper

Before you print, load paper for the type of printing you will do.

Loading Paper in the Cassette

Loading Paper in the Rear Paper Feed

Paper Loading Capacity

Double-sided Printing Capacity

Compatible Epson Papers

Paper or Media Type Settings - Printing Software

Loading Paper in the Cassette
You can load paper up to this size in the paper cassette: Legal (8.5 x 14 inches [216 x 356 mm]).

Note: Before loading paper, make sure your product is not currently printing.

1. Open the paper cassette cover.

Ve
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2. Pull out the paper cassette until it stops.

Note: You cannot remove the paper cassette.

3. Slide the edge guides outward.
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4. Do one of the following:
* Insert paper into the cassette with the printable side facedown and slide it in until it stops.

Note: Make sure the paper is loaded against the rear of the cassette.

» For legal-size paper, load paper using the guide line as shown.
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* For 8.5 x 13 inch (216 x 330 mm) paper, load paper using the guide line as shown.

4 )
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5. Slide the edge guides against the paper, but not too tightly.

Note: Make sure the paper fits under the tabs on the edge guides.

6. Slide the cassette back into the product until it stops.
7. Do one of the following:
» Close the paper cassette cover.

+ If you loaded envelopes, thick paper, or business cards, lower the output selector to eject paper to
the front of the printer and leave the paper cassette cover open.

Note: Do not remove or insert the paper cassette during printing.

Always follow these paper loading guidelines:
* Load only the recommended number of sheets.
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* Load paper short edge first and printable side facedown.
» Load letterhead or pre-printed paper top edge first.

* Make sure the paper fits under the tabs on the edge guides and does not stick out from the rear of
the cassette.

 If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load
one envelope at a time.

« If print quality declines when printing multiple envelopes, try loading one envelope at a time.
» Do not load an envelope that is curled, folded, or too thin, or that has a plastic window.
» Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references
Paper Loading Capacity
Double-sided Printing Capacity

Loading Paper in the Rear Paper Feed
You can print documents on a variety of paper types and sizes from the rear paper feed slot.
1. Flip the feeder guard forward.

I
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2. Slide the edge guides out all the way.

"g—_ﬁ*ﬁ‘ﬁ\
\

3. Do one of the following:

* Insert one sheet of paper printable side up and short edge first, in the center of the rear paper feed

slot.

» Load one envelope in the center of the rear paper feed slot. Load it printable side up and flap edge

left.

=
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» Load one sheet of loose-leaf or other paper with holes facing as shown. You can load one sheet at
a time in only these sizes: Letter (8.5 x 11 inches [216 x 279 mm]), A4 (8.3 x 11.7 inches
[210 x 297 mm]), or Legal (8.5 x 14 inches [216 x 356 mm]).

00000000

I—

000000000000
000000000000

\ 4 ¥

000000000000

4. Slide the edge guides against the paper, but not too tightly.

5. If you loaded envelopes or thick paper, open the paper cassette cover, lower the output selector to
eject paper to the front of the printer, and leave the paper cassette cover open.
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Always follow these paper loading guidelines:

Load only one sheet or envelope at a time.

Load paper short edge first and printable side up.

Load letterhead or pre-printed paper top edge first.

If you have trouble loading an envelope, press it flat before loading it.

Do not load an envelope that is curled, folded, or too thin, or that has a plastic window.
Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references
Paper Loading Capacity
Double-sided Printing Capacity

Paper Loading Capacity

Note: The output tray holds up to 100 sheets of plain paper. Exceeding this limit can cause paper to fall
or a paper jam to occur. Remove printouts as necessary to keep the amount of paper in the output tray
under 100 sheets.
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Paper type

Loading capacity

Cassette Rear paper feed
Plain paper Letter (8.5 x 11 inches 1 sheet
[216 x 279 mm]) or A4
Copy paper (8.3 x 11.7 inches
Letterhead paper [210 x 297 mm)]) size or
High quality plain paper smaller: 250 sheets
Legal (8.5 x 14 inches
[216 x 356 mm]) size: 1 sheet
User-defined (3.5 x 5inches |—
[89 x 127 mm] t0 8.5 x 47.2
inches [215.9 x 1200 mm]): 1
sheet
User-defined (2.1 x 3.4 inches |1 sheet
[54 x 86 mm] to 8.5 x 47.2
inches [215.9 x 1200 mm]): —
User-defined (7.2 x 10.1
inches [182 x 257 mm] to
8.5 % 11.7 inches [215.9 x 297
mm]): 1 sheet
Epson Bright White Pro Paper 200 sheets
Epson Bright White Premium Paper
Epson Multipurpose Plus Paper
Epson Presentation Paper Matte 100 sheets
Epson Premium Presentation Paper Matte |20 sheets
Epson Premium Presentation Paper Matte |1 sheet
Double-sided
Epson Ultra Premium Presentation Paper |—
Matte
Thick paper (25 to 68 Ib [91 to 256 g/m?])
Envelopes 10 envelopes 1 envelope

Parent topic: Loading Paper
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Double-sided Printing Capacity

You can print double-sided on the paper types and sizes listed here.

Paper type Size Double-sided printing capacity
Cassette Rear paper
feed
Plain paper Letter (8.5 x 11 inches 250 sheets 1 sheet
Copy paper [216 x 279 mm]) or A4

(8.3 x 11.7 inches
High quality plain paper [210 x 297 mm]) or
smaller

User-defined (7.2 x 10.1 |1 sheet
inches [182 x 257 mm] to
8.5 % 11.7 inches [215.9 x

297 mmy])
Epson Bright White Pro Letter (8.5 x 11 inches 200 sheets
Paper [216 x 279 mm])

Epson Bright White
Premium Paper

Epson Multipurpose Plus
Paper

You cannot print double-sided on the following paper types:
* Epson Presentation Paper Matte

* Epson Premium Presentation Paper Matte

* Epson Premium Presentation Paper Matte Double-sided
* Epson Ultra Premium Presentation Paper Matte

* Envelopes

Parent topic: Loading Paper

Compatible Epson Papers

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales),
epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from
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https://www.epson.com
https://www.epson.ca
https://epson.com.jm

an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S.

or 800-807-7766 in Canada.

Note: Paper/media availability varies by country.

Paper Matte

[216 x 279 mm])

Paper Type Size Part number Sheet count

Epson Bright White Pro Paper Letter (8.5 x 11 inches S041586 500
[216 x 279 mm])

Epson Bright White Premium Letter (8.5 x 11 inches S450218-4 500

Paper [216 x 279 mm])

Epson Multipurpose Plus Paper Letter (8.5 x 11 inches S450217-4 500
[216 x 279 mm])

Epson Presentation Paper Matte | Letter (8.5 x 11 inches S041062 100
[216 x 279 mm])
Legal (8.5 x 14 inches S041067 100
[216 x 356 mm])

Epson Premium Presentation 8 x 10 inches (203 x 254 mm) | S041467 50

Paper Matte Letter (8.5 x 11 inches S041257 50
[216 x 279 mmi) S042180 100

Epson Premium Presentation Letter (8.5 x 11 inches S041568 50

Paper Matte Double-sided [216 x 279 mm])

Epson Ultra Premium Presentation | Letter (8.5 x 11 inches S041341 50

Parent topic: Loading Paper
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Paper or Media Type Settings - Printing Software

For this paper Select this paper Type or Media Type setting

Plain paper Plain Paper / Bright White Paper
Epson Bright White Pro Paper
Epson Bright White Premium Paper
Epson Multipurpose Plus Paper

Letterhead paper Letterhead

Epson Ultra Premium Presentation Paper Matte Card Stock
Thick paper 25 to 68 Ib (91 to 256 g/m?)

Epson Presentation Paper Matte Presentation Paper Matte

Epson Premium Presentation Paper Matte Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-

sided

Envelopes Envelope

Parent topic: Loading Paper
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Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with the Standard Epson Printer Software - Windows
Printing with the Built-in Epson Driver - Windows 10 S
Printing on a Mac

Printing with the Epson Universal Print Driver - Windows
Printing From a Chromebook

Cancelling Printing Using a Product Button

Printing with the Standard Epson Printer Software - Windows

You can print with the standard Epson printer software using any Windows printing program, as
described in these sections.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows

Selecting Extended Settings - Windows

Printing Your Document - Windows

Locking Printer Settings - Windows

Selecting Default Print Settings - Windows

Changing Automatic Update Options
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Parent topic: Printing from a Computer

Related tasks
Printing From a Chromebook

Related topics
Printing with the Built-in Epson Driver - Windows 10 S
Printing with the Epson Universal Print Driver - Windows

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.
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You see the Main tab of your printer settings window:

% Prnvting Preferences b
Man  More Options  Manterance
Printing Prescls Paper Source Pt Select bt
Add Remdve Precets.,. Creeciamien® Soe Lether (2.5 x 11in) e
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=1 Dooument - Standard Qualiy Crientaten Oberrat @ oo
B Deument - Hagh Qualty
"" Document - 2-Sded Pager Type Plair Pagser [ Bright Whiie Pager ”
Ale] Decurmepnit - 2400
(50 Doument - 2Guied with 240 Guabiy Standard w
IadedPrntng  |OFF N
R M Page off w
u_] ) i P A Colase
— ﬂ :Llﬂj [everse Grder
5 Qb Mode o W
Sz Settrgs [Jpeet Previem
Sy Asvanger Lt
Riedet Dafpits Ik L .
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For the Paper Source setting, select where you loaded the paper you want to print on.
Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.
Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.
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8. Select the Quality setting that matches the print quality you want to use.
9. To print on both sides of the paper, select a 2-Sided Printing option.

10. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

11. To print multiple copies and arrange their print order, select the Copies options.
12. To preview your job before printing, select Print Preview.

13. To save your print job as a project that can be modified and combined with other print jobs, select
Job Arranger Lite.

14. To reduce noise during printing when you select Plain Paper/Bright White Paper, select On in the
Quiet Mode menu.

Note: Enabling Quiet Mode may reduce printing speed.

Paper Source Options - Windows

Print Quality Options - Windows

Multi-Page Printing Options - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Selecting Double-sided Printing Settings - Windows

Paper Source Options - Windows

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Auto Select
Automatically selects the paper source based on the selected paper size.

Paper Cassette
Selects the paper in the cassette as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Windows
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Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.

Draft
For draft printing on plain paper.
Standard
For everyday text and image printing.
High
For photos and graphics with high print quality.
Parent topic: Selecting Basic Print Settings - Windows
Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
2-Up and 4-Up

Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2x1 Poster, 2x2 Poster, 3x3 Poster, 4x4 Poster

Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows

You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

2-Sided Printing | Off W
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Select one of the following options for 2-Sided Printing:

* Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper
on the long edge.

» Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper
on the short edge.

Click the Settings button.
You see this window:

Binding Settings

Left | Top Right
® L ong-edge O shoct-edge O Long-edge

Binding Margin

-

Front Page [0.00 = [0.00... 1.18]

Back Page [0.00 =) [0.00... 1.18]

Uit Cmm (®) inch

Start Page
(®) From Front

(C) From Back

Create Folded Bookdet
[C]Bocidet

" mr ber Bircbna P [ L G
Centber Bandang Oe EncEng

A

i e

Select the double-sided printing options you want to use.
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7.
8.
9.
10.

Click OK to return to the Main tab.
Click the Print Density button.
You see this window:

Print Density Adjustment

Select Document Type

() Text (®)Text & Graphicss () Text & Photos () User-Defined
Adjustments
Print Density L | 0 (%)
-50 Q
Increase Ink Drying Time " il (sexc)
0 ]

R

Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

If necessary, select the Adjustments options you want to use.

Click OK to return to the Main tab.

Print a test copy of your double-sided document to test the selected settings.
Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows
Print Density Adjustments - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows

Related tasks
Selecting Basic Print Settings - Windows
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Double-sided Printing Options - Windows

You can select any of the available options on the 2-Sided Printing Settings window to set up your
double-sided print job.

Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.

Print Density
Sets the level of ink coverage for double-sided printing.

Increase Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows

You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.

= Prsbing Prefenences ®

Man  More Optons  Mantenance

Prinking Prescls Denmnent Sioe Lether (3.5 x 11 in) i
Add Fremive Presets... hpionst Papr Same &5 Document Size bt

=] Dodament - Fadt [l Rt Eriarge Dedurmens
] Denuement « Standard Quality N .
SN Document - High Qualty

£ Dooument - 2-Saded

AL Deasment - 248

) Tone Cormecton
(L) Deuement « 2-Guded with 240g .
() dustorma e O Cuttom
Emage Ophions...
Watermark Features...

— Sckcdtonal Settrn

'—'ll_] [Ceotate 150

L [mteres bmagee
Sk Setengs
Retet Defputs

R

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:

» Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your
document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

+ Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Tone Correction options:
+ Select Automatic to automatically adjust the brightness and contrast for your image.
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+ Select Custom and click the Advanced button to manually adjust the tone correction settings or
turn off color management in your printer software.

+ Select Image Options to access additional settings for improving printed images.
3. To add the following features, click the Watermark Features button:
* Anti-Copy Pattern: adds a watermark that only appears when your printout is copied
» Watermark: adds a visible watermark to your printout
* Header/Footer: adds information such as the date and time to the top or bottom of your printout

Note: Click the Settings button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.

Custom Tone Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows
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Custom Tone Correction Options - Windows

You can select any of the available options in the Tone Correction window to customize the image tone
for your print job.

Tene Correction

e n—..:m, S g

<0riginal Photo> <Preview>

Gamma 2.2

Brightness ID_I ] v
Contrast EI i v
(o] cona || mo

Gamma

Adjusts the midtone density of the image.
Brightness

Adjusts the overall lightness and darkness of the image.
Contrast

Adjusts the difference between the light and dark areas of the overall image.
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Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.
Image Options

Emphasize Text
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

Enhance Light Text and Lines
Adjusts the weight of light text and printed lines to increase visibility.
Additional Settings Options

Rotate 180°
Prints the image rotated 180° from its original orientation.

High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.
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Note: These settings are not saved with your document.

Header/Footer Settings

Top Left Top Center Top Right

Uger MName w Mons v Date,Time o
Bottom Left Bottom Cenber Bottom Right

None b MHone il Mone bl

Resst Defaults IE Cancel Help

You can select to print the following information:
* User Name

» Computer Name

* Date

* Date/Time

* Document Name

» Collate Number

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
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You see the available Printing Presets on the left:

f= Printing Preferences
Main  More Options  Maintenance

Printing Presets

Add/Remove Presets...

E] Document - Fast

E] Document - Standard Quality
E Document - High Quality

2 Document - 2-Sided

Document - 2-Up
EL) Document - 2-Sided with 2-Up

il .

Show Settings

Reset Defaults Ink Levels

2. Place your cursor over one of the Printing Presets to view its list of settings.
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3. Click on a preset to change its settings, or use any of the available options on the screen to control
your printing presets.

4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with the Standard Epson Printer Software - Windows

Selecting Extended Settings - Windows

You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the h-; icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click £,

Select Printer Settings.
3. Click the Maintenance tab.
You see the maintenance options:

= EPSON =
Man Mo Optons  Wartensnce
-@ Mearsie Chied E EPSOH Status Moritor 3
}:\. Head Cearing gl Moo Preferences
% Powey Cleaning
BB PrintHead Algrment % Extended Settngs
.H Paper Gusde Cheanng #1 Print Quesue
@‘ Joby Asranger Lite % Primber anef Opbon [nformaton
Lerguaage Eruglsh (Engiah] - By Safteare Update
Wersan 2.60.00.00 Oriine Support
O, Concal Helgr
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4. Click the Extended Settings button.
You see this window:
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5. Select any of the extended settings to customize your print.

6. Click OK to close the Extended Settings window.

7. Click OK to close the printer software window.

Extended Settings - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows
Extended Settings - Windows

You can select these settings on the Extended Settings window.

Enable EPSON Status Monitor 3
Enables product monitoring for ink and paper supplies and other issues.

Short Grain Paper
Prevents ink from smearing when you print on envelopes or other thick paper.

Separator Page
Before each document, prints a separator page containing the title, user, date, and time.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.
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Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Barcode mode
Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper,
preprinted paper, envelopes, and thick paper.

Reduce Print Data Size
Increases print data compression to improve print speed. Not recommended when printing fine
patterns.

Increase Print Speed in Standard Mode
Increases print speed when printing on plain paper with a Standard Quality setting.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

X

= Pnnt

Generd  Qipbons

Select Printer

T8 EPSON = Microsoft XPS Docummen
= Fax

= Microseft Print ta PDF

£ ¥
Status Ready im tofie | Preferences §
Locabson:
Commeant Fing Pringer...
Page Range

CIE| Mumber of copies: |1 &

) Pages: 1 Collate

- 23 [ 523
Enter either a single page number or a sngle 1 1

page rangs. For example, 512

2. Click OK or Print to start printing.
Parent topic: Printing with the Standard Epson Printer Software - Windows

Locking Printer Settings - Windows
Windows administrators can lock access to some printer settings to prevent unauthorized changes.

1. Do one of the following:

* Windows 10: Click E and select k=4 (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printer properties.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product and select Printer properties.

* Windows 7: Click E’ and select Devices and Printers. Right-click your product and select
Printer properties.
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+ Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product and select Properties.

2. Click the Optional Settings tab.

Note: You can prevent access to the Optional Settings tab by changing the user or group
permissions in the Security tab.

3. Click Driver Settings.
You see this window:

Dirwer Settings

Bederares frator Levk Funcion Bbverced Settngs
[ ansi-Copy Fatten

[ Watermark

] e ticr Fontier

[ 2-mded printing
[ e rage

[l Bccument Sestings:

S - R

4. Select the checkbox for each setting you want to lock. To lock all print settings, select All Document
Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.

Locked Setting Options

Parent topic: Printing with the Standard Epson Printer Software - Windows
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Locked Setting Options

Select the options you want to use for any locked print settings.

Setting Options Description
Anti-Copy Various data items Lets you select the data to use for the pattern or prohibit anti-
Pattern copy patterns
Add/Delete Lets you add or delete a customized anti-copy pattern
Settings Lets you select the arrangement, size, and other settings for
the custom anti-copy pattern
Watermark Various text Lets you select the text for the watermark or prohibit

watermarks watermarks

Add/Delete Lets you add or delete a customized text or image-based
watermark

Settings Lets you select the size, position, and other watermark

settings

Header/Footer Off Prohibits headers or footers

On Allows headers and footers

Settings Lets you select the text and position for printing headers and

footers

2-sided printing | Off Allows printing on one side of the paper only

On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings

2-Up Allows printing of 2 pages on one sheet of paper

4-Up Allows printing of 4 pages on one sheet of paper

Parent topic: Locking Printer Settings - Windows

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
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1. Access the Windows Desktop and right-click the 3"-‘ icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click !l.-‘

2. Select Printer Settings.
You see the printer settings window:

% Prnvting Preferences b
Man  More Options  Manterance
Printing Prescls Paper Source Pt Select bt
Add Riamave Presets.,. Docunent Spe  Letier (2.5 x 11 in) b
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Changing the Language of the Printer Software Screens

Parent topic: Printing with the Standard Epson Printer Software - Windows
Changing the Language of the Printer Software Screens

You can change the language used on the Windows printer software screens.
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1. Access the Windows Desktop and right-click the 3‘3 icoRfor your product in the right side of the
Windows taskbar, or click the up arrow and right-click 2%,

2. Select Printer Settings.
You see the printer settings window.

3. Click the Maintenance tab.
You see the maintenance options:

== EPS0N =

Msn Mo Options  Martenance

‘@ Feorie Chedc @ EPSON Status Mortor 3

‘b\ Head Clearing @ Mot Freferences

% Porewer Clening
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Leruge Englsh (Engish) ¥ B saftware Lindate

Wersan 2.60,00.00 Orine Support
O Corcal Helgr

4. Select the language you want to use as the Language setting.

5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows
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Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the !1-; icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Software Update Settings.
You see this window:

Software Update Settings X

Check for Software Updates on the Internet

(®) Check every 2 wesks w

L:,I Mewer

cancel

3. Do one of the following:

» To change how often the software checks for updates, select a setting in the Check every menu.
» To disable the automatic update feature, select the Never option.
4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with the Standard Epson Printer Software - Windows
Related tasks
Checking for Software Updates
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Printing with the Built-in Epson Driver - Windows 10 S
You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as
described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your
product. To print with additional settings, download and install the Epson Print and Scan utility from the
Windows Store. You cannot download and install any Epson product software from the Epson website
for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Print Settings - Windows 10 S
Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S

Select the settings for your print job in your Windows 10 S application.
1. Open a document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.
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You see a window like this:

% Epson ESC/P-R VA Class Driver Printing Preferences A
Layoud  Papes/Cusity
Tray Sedection
Advanced...
Concel | [ ooty

Select the type of paper you loaded as the Media setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

Click the Advanced button.
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You see a window like this:

Epson ESC/P-R V4 Class Driver Advanced Options H

me Epson ESC/P-R V4 Class Driver Advanced Document Settings
=11 Paper/Qutput

Paper Size: Lether

Copy Count: || = Collated

Select the size of the paper you loaded as the Paper Size setting.

To print multiple copies, select or enter the number as the Copy Count setting.

To print multiple copies of multi-page documents in sets, select the Collated checkbox.
Click OK.

You return to the printing preferences window.
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10. Select the Layout tab.

i Epson ESC/P-R VA Class Diiver Printing Preferences b

Layout  Pages/Chulty

Crientation:

(B oot

Prant on Both Sedes:
4 Mone V]

[0

Advanced_..

I =T

11. Select the orientation of your document as the Orientation setting.
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12. To print double-sided, select one of the Print on Both Sides options, depending on how you want to
orient the page layout. The icon next to each option shows the layout.

" Epson ESC/P-R VY Class Dirvwer F'nn-.mg Preferences oo
Lavoul  Paper/Clualty
Orientation:
(%] Partrait

Prant on Both Sedes:
A Mone w

EF Flip on Long Edge
§ Fip on Short Edge

Advanced_..

[ ok ][ conce

13. Click OK to save your settings.
You see your application's Print window.
14. Click OK or Print to start printing.
Parent topic: Printing with the Built-in Epson Driver - Windows 10 S

Printing on a Mac

You can print with your product using any Mac printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
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Selecting Print Layout Options - Mac

Selecting Double-sided Printing Settings - Mac
Selecting Printing Preferences - Mac

Printing Your Document - Mac

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Mac
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

Printer: EPSOM

[+ |
Prasets: Default Settings [~ |

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Printer: EPSON o
Presets: Default Settings H
Copies: (1
Pages: © all
Selected Page in Sidebar
From: 1 to: |1
Paper Size: US Letter E B.50 by 11.00 inches

Orientation: If s

Preview E

Auto Rotate Show Notes
Scale:
D Scale to Fit: D Print Entire Image

Fill Entire Faper

Copies per page: 1 E

Cancel m

Note: The print window may look different, depending on the Mac OS version and the application
you are using.

Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

Select Print Settings or Printer Features from the pop-up menu.

v Preview

Layout

Color Matching
Paper Handling
Cover Page

Print Settings
Two-sided Printing Settings

You see these settings:

Print Settings -

L]

Paper Source:  Auto Select

Media Type: Plain Paper [ Bright White Paper

(%]

Print Quality: Marmal

L%

¥ Advanced Settings:

Cancel Print
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Note: The available print settings and appearance of the print window may be different than those
covered here, depending on the Mac OS version and the application you are using.

9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.

Paper Source Options - Mac
Print Quality Options - Mac

Parent topic: Printing on a Mac

Related tasks
Selecting Page Setup Settings - Mac

Paper Source Options - Mac

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Auto Select
Automatically selects the paper source based on the selected paper size.

Paper Cassette
Selects the paper in the cassette as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Mac
Print Quality Options - Mac

You can select any of the available Print Quality options to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type setting you have chosen.

Draft
For draft printing on plain paper.

Normal
For everyday text and image printing.
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Fine
For text and graphics with good quality and print speed.

Quality
For text and graphics with increased quality and print speed.

Best Quality
For the best print quality, but the slowest print speed.

Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac

Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Paper Size: US Letter - B.50 by 11.00 inches

Orientation: || g I

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing on a Mac
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Selecting Print Layout Options - Mac

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

Layout

LT

<2

Pages per Sheet: 1

Border: None

i

wo-Sided

Reverse page orientation
Flip hornizontally

Cancel Print

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.

» To print on both sides of each page, select a setting from the Two-Sided pop-up menu.

» Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing on a Mac

Selecting Double-sided Printing Settings - Mac

You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Two-sided Printing Settings &

Two-sided Printing:  Off

(4]

80



Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the Mac
OS version you are using.

Select one of the Two-sided Printing options.

2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

Two-sided Printing Settings &

L

Two-sided Printing:  Long-Edge binding

Document Type: Text

€3

¥ Adjustments:
Print Dansity
0 (3]
-50 0
Increased Ink Drying Time:
li] (sec)
4] +50

When printing a photo or document containing a lot of solid image
areas, reduce the density of the ink and increase its drying time.

Cancel Print

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options and Adjustments - Mac

Parent topic: Printing on a Mac
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Double-sided Printing Options and Adjustments - Mac

You can select any of the available options in the Two-sided Printing Settings pop-up menu to set up
your double-sided print job.

Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.

Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - Mac

Selecting Printing Preferences - Mac
You can select printing preferences that apply to all the print jobs you send to your product.
1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
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You see a screen like this:

General Options  Supply Levels  Utility

To take full advantage of your printer's options, confiem that they ane scouratoly shown
here, For information on your printer and it optional hardwang, chedk the prinjer's
deumanilalen.
Skip Black Page: | Off I
Cuist Made: | 08 O
High Spood Prirting: On
Warning Notifications: | On <

Establish tidirectcingl commaracaton: Oon 5

Cancel [+].4

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - Mac
Parent topic: Printing on a Mac
Printing Preferences - Mac
You can select these settings on the Options or Driver tab.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Quiet Mode
Lessens noise during printing but may decrease print speed.

High Speed Printing
Speeds up printing but may reduce print quality.
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Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document - Mac
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Print Settings -

(4]

Paper Source: Auto Select

¥

Media Type: Plain Paper [ Bright White Paper

¥

Print Quality: MNorma

Advanced Settings:

Cancel Print

Checking Print Status - Mac
Parent topic: Printing on a Mac
Checking Print Status - Mac
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.

84



You see the print status window:

@0 e ™= EpPSONM
I\\l—l--"" [ .-.-1'.
Paugs Settings

Dacument, pdf

-

Primting - 2 pages

2. Select the following options as necessary for your Mac OS version:
* To cancel printing, click the print job and click I:l or Delete.

* To pause a print job, click the print job and click I:' or Hold. To resume a print job, click the
paused print job and click |:| or Resume.
» To pause printing for all queued print jobs, click Pause or Pause Printer.
» To display other printer information, click Settings or Supply Levels.
Parent topic: Printing Your Document - Mac

Printing with the Epson Universal Print Driver - Windows

You can print with the Epson Universal Print Driver using any Windows printing program, as described in
these sections.

Installing the Epson Universal Print Driver - Windows

Synchronizing Printer Settings - Epson Universal Print Driver - Windows

Selecting Print Settings - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows

Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows
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Parent topic: Printing from a Computer

Installing the Epson Universal Print Driver - Windows

The Epson Universal Print Driver supports multiple printer languages, such as PCL and ESC/P-R, and
can be installed on a Windows computer. Before enabling Epson Universal Print Driver (PCL) printing on
your product, make sure you have installed the software as described on the Start Here sheet.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software. Depending on your model, not all printer languages may be supported.

1. To download the EPSON Universal Print Driver file, visit epson.com/support (U.S.),
epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

2. After downloading the installer file, double-click the downloaded file to install the software.
3. Follow the on-screen instructions until you see this screen:

EPSOM Printer Litilities Setup

Detect the printer, and automatically corfigure the: part
Is the printer connected via a network ?

() Yes: Hetwork connechar]

Ssarch oplions ...

e 'F: ) No: USE connesction

[[] Set Defaut of Frinter Corbrol Language to PCLE

OK Abort

4. Select Yes: Network connection and click OK.
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http://www.epson.com/support
http://www.epson.ca/support
https://epson.com.jm/Support/sl/s

Note: Select the Set Default of Printer Control Language to PCL6 checkbox if you want to set the
default printer language to PCL6. Leave this option deselected to set the printer language to ESC/P-
R. (You can change this setting later as needed.)

After the software finishes searching for products, you see a screen like this:

! EPS0OM Printer LHilities Setup 7 by
(%) Add EPSON Uiniwansal Print Driver
() Add fiound penters
Salad & pail ta carmect & prrler
Select from found penters -
Found Printers:
Maodel Name P Address MAL Address Location
WIP-20000 192 16813000 DO2GABFREDIC
WF- 30000 192168 .7 3000 ACTEMEACENSC Linkerizai
WF- 2000 192 1681000 DOREABFFISED Unkngrm
L4 *
£] Set ax default parter Diaplay Settinga
= I

5. Do one of the following:

* If you are installing one product, make sure Add EPSON Universal Print Driver is selected and
continue with the next step.
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* If you are installing more than one product, select Add found printers and go to step 9.
Note: You can customize and filter your product search results by clicking Display Settings.

Open the Select a port to connect a printer menu and select an existing printer port, if necessary.
Otherwise, skip this option to create a new port automatically.

Select the product you want to install from the Found Printers list.

Note: Deselect the Set as default printer checkbox if you do not want the product to be set as your
default printer.

Click OK, then skip the remaining steps.

88



9. Ifyou are installing more than one product, select the products from the Found Printers list and click
Add to Printer Folder.

[ EPSOM Printer Uitilities Setup 1 x

) Add EPSON Uiniwansal Print Driver
(%) Add found perters

Salact prirfers from the falowing lisl, and then dick the *Add ta Prinber Falder” buflen . (You can
sedect mukiple: printers from the list }

Found Printers.
Modsl Name IF Address MAL Address Locaton il
WFCR0 19216813000 AC 1826285731
V-0 153 1681 3000 B4EBBC2ES1CE
WE- N0 192 168.1.30004 B4EBBCTATFED
WP 192 163 12000 DO2GABFREDIC
W00 152 1687000 ACTEMEICE0SC
ET- 2000 19216813000 4402440483410
AEFC 10°% 1£0 1 NICADCC3EOMN v
€ >
Add to Prrer Folder | Diaplay Settings
Primters to be added:
Name of added prirter IP Address

[ EPSOM Universal Print Dierver WF- 10004 192,168, 1. 3000
(] EPSOM Universal Print Detver WF-1000 1521881000

Dedeta Edt

Select i prinber from the list 1o =8t @ &2 the defaull prinber

Help Aot 0K Back

The selected products appear in the lower section of the screen.
10. Select the checkbox next to the product you want to make your default printer, if necessary.
11. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows
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Synchronizing Printer Settings - Epson Universal Print Driver - Windows

You may need to synchronize the printer driver with the product if the printer driver does not detect the
correct information or settings from the product.

1. Do one of the following:

- Windows 10: Click &l and select (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printer properties.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

+ Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

2. Click the Optional Settings tab.
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You see a window like this:

78 EPSOM Unncersal Print Deiver Properies =

Genersl Shasng Forlr  Achvanced  Color Mermgemsnl  Sscurty  Oolional Sefings  Visrmion Infomeston

% Pranber Lithty

=
'ﬁ_ Metwork prnter seanch
%

‘:h- Dvivier S4ttings

CuFTent Frinter Infonmason

Printsr Tnfermaton

Prindar Typd A

Trikcjeet Prinber (W) Acguire from Printer Get
Hade Mame

WF-HHKE Senes [ ondy Cptional Tnformartion
Priver Moded

AdiLetter Codor (5tandand Resolubon &00

Default of Printer Control Language (_}Manusl Setings
ESCFHR
Ak Dupheer Instaed
Trestabi
Confidentia Job s
<8 »
0K Cancal [Hasip

3. Make sure Acquire from Printer is selected and click Get.

The product's settings and other information appears in the Current Printer Information area.
4. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows

Selecting Print Settings - Epson Universal Print Driver - Windows
Select the basic settings for the document or photo you want to print.

Note: The names of settings on the universal print driver screens may vary slightly, depending on the
version of the print driver you have installed.

1. Open a photo or document for printing.
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2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Ifnecessary, select EPSON Universal Print Driver as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

&% Prsting Preferences ®
Man  More Options  Manterance
FPrinting Prescls Poper Sourge Pt Select b
Add Remdve Precets.,. Creeciamien® Soe Lether (2 12 x 11in) -
B Document - Standand
<2l Document - 245 Crientason OiPertat ) Lancage
£l Doasment - 2:5ded
12 Document - 2-Saded with 240p Paper Type Flain Paper | Bright White Paper e
Quanty Stanclard ™
IadedPrntng  |OFF N
Settra...
M Fage off b
—_— Copies 1 - £ Colate
[ , ) Freverse Grder
—— 1
vt Breview D30k aerarger Lite
Show Setungs
Refet Defpuits
e || e

Note: For more information about a setting, right-click it and select Help.

4. Forthe Paper Source setting, select where you loaded the paper you want to print on.
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5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.
6. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.
7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select any of the available print options.

9. To select a variety of additional layout and printing options for your document or photo, select the
More Options tab and select the printing options you want.

10. To select maintenance and other optional settings, select the Maintenance tab and select the
options you want.

Parent topic: Printing with the Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Do one of the following:

* Windows 10: Click E and select k4 (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printing Preferences.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Print Preferences.

* Windows 7: Click E‘ and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printing Preferences.

* Windows Vista: Click © and select Control Panel. Click Printer under Hardware and Sound,
right-click EPSON Universal Print Driver, and select Printing Preferences.
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You see the printer settings window:

=

Man  More Options  Manterance

Printing Presels Pagpeer Sounce At Select -
Add Remdve Precets.,. Creeciamien® Soe Lether (2 12 x 11in) -
=] Document - Standard
] Cecument - 24 Orentaton @) Pertain Civenscace
£ Decumment « 2-5uded
L) Document - 2-5ded with 24Up Paper Tipe Flain Paper | Bright White Paper e
Cuaslity Standand ~

IadedPrntng  |OFF L

Settrg...
— W P e o e
E Copees i = B Colate
u "_'id-’l '_“.Adkl EAReverse Cnder
Show Setengs (et Previe [ 3k arranger Lie
Foeet D fguits
QK Canscel . Helgy

Note: For more information about a setting, right-click it and select Help.

2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Parent topic: Printing with the Epson Universal Print Driver - Windows

Locking Printer Settings - Epson Universal Print Driver - Windows

Administrators can lock some printer settings to prevent unauthorized changes.
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1. Do one of the following:

* Windows 10: Click I:I and select k=4 (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printer properties.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click E' and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

2. Click the Optional Settings tab.
3. Click Driver Settings.
You see this window:

Derer Settinegs

Admnsirator Lo Function Advanoed Settngs

] ventermark
[ resaior Footer

[] 2-sded printirg
] Mudm dage

[C] Al Dot Setares

ResetDefoits | [ o | | Conce Help

4. Select the checkbox for the settings you want to lock. To lock all print settings, select All Document
Settings.
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5. Under Advanced Settings, select the setting option you want to use for each locked setting.

6. Click OK.

Epson Universal Print Driver Locked Setting Options

Parent topic: Printing with the Epson Universal Print Driver - Windows

Epson Universal Print Driver Locked Setting Options

Select the options you want to use for any locked print settings.

Setting

Options

Description

Watermark

Various text

Lets you select the text for the watermark or prohibit

watermarks watermarks

Add/Delete Lets you add or delete a customized text or image-based
watermark

Settings Lets you select the size, position, and other watermark
settings

Header/Footer Off Prohibits headers or footers

On Allows headers and footers
Settings Lets you select the text and position for printing headers and
footers

2-sided printing | Off Allows printing on only one side of the paper

On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings

2-Up Allows printing of 2 pages on one sheet of paper

4-Up Allows printing of 4 pages on one sheet of paper

Parent topic: Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows
You can use the Epson Universal Print Driver to find and add network printers.
1. Do one of the following:

* Windows 10: Click IEI and select k¥4 (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printer properties.
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+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click E and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

* Windows Vista: Click E and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.
Click the Optional Settings tab.

You see this window:

& EPSOM Unncersal Print Drives Properties =

Genersl Shasng Forlr  Achvanced  Color Mermgemsnl  Sscurty  Oolional Sefings  Visrmion Infomeston

}\ Pranber Lithty

e
:5.5! Metwork printer seanch
%

‘:h- Dvivier S4ttings

CuFTent Frinter Infonmason

Printsr Tnfermaton

Prindar Typd A

Trikcjeet Prinber (W) Acguire from Printer Get
o] Hame

WF-HHKE Senes [ ondy Cptional Tnformartion
Priver Moded

AdiLetter Codor (5tandand Resolubon &00

Default of Printer Control Language (_}Manusl Setings
ESCFHR
Ak Dupheer Instaed
Trestabi
Confidentia Job s
<8 »
0K Cancal [Hasip

Click Network printer search.
When you see the search results, select Add found printers.
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You see a screen like this:

i! EPS0OM Printer LHilities Setup 7 ®

() Add EPSON Uriversal Print Dviver

(%) Add found perters
Salact prirfers from the falowing lisl, and then dick the *Add ta Prinber Falder” buflen . (You can
sedect mukiple: printers from the list }
Found Printers.
Modsl Name IF Address MAL Address Locaton il
W20 192 16813000 AC1B2E2B5TI
V-0 152 1681000 B4EBBC2551CE
WF- 20000 192 168110004 BAEBBCTATFID
WP 192168130001 DO2GABFREDIC
WF-20000 152 168110000 ACTRIEACS05C
ET- X0 192 16813000 440244048380
AEFC 10% 160 1 NICADCC3EOMN v
< >
| Add to Prrer Folder | Diaplay Settings

Printers to be added:

Name of added prinler IP Address

[] EPSOM Universal Print Derver WF- 50000 152,168, 1. 5000
(] EFSOM Universal Print Detver WF-20000 152.168.1.5000C

Dedeta Edt

Selecd & prinber from the i 1o & § &= the defaul prnber

Help Aot 0K Back

5. Select the printer or printers you want to add.
6. Click Add to Printer Folder.
The selected printer or printers appear in the lower section of the screen.
7. Select the checkbox next to the product you want to make your default printer, if necessary.
8. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows
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Printing From a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

Note: See your Chromebook's documentation for details on connecting to a network.

3. Do one of the following:

» Click Add to Cloud Print in the notification that appears in the corner of your Chromebook
screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

* Open a web browser and enter chrome://devices in the address bar. Skip to step 5.
* If you see a registration confirmation screen instead, click Register.

Click Add Device.

Click the Register button that appears next to your product.

Click Register on the confirmation screen.

No o bk

Select OK or press the OK button on your product to confirm the Google Cloud Print connection and
print a test page.

8. To print to the connected product, select the print command in your Chrome app.

Your product is now linked to your Google Account and can be accessed from any Chromebook where
you are logged in, as long as you have Internet access. Visit Epson Support for Google Cloud Print (U.S)
or Epson Support for Google Cloud Print (Canada) for more information on using Google Cloud Print, or
the Google Cloud Print website for a list of supported apps.

Parent topic: Printing from a Computer

Related topics
Wi-Fi or Wired Networking

Cancelling Printing Using a Product Button

If you need to cancel printing, press the @ stop button on your product.
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http://www.google.com/cloudprint/learn/index.html
http://www.google.com/cloudprint/learn/apps.html

Parent topic: Printing from a Computer
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Refilling Ink and Replacing the Maintenance Box

When the ink level is below the lowest line on the ink tank, you need to refill it. Periodically check the ink
tank to see if it needs to be refilled.

Before checking the ink level or refilling an ink tank as described here, be sure to read the ink safety
precautions.

Caution: If the ink level is below the lower line on the ink tank, fill it to the upper line on the ink tank.
Continued use of the product when the ink level is below the lower line on a tank could damage the
product.

Ink Safety Precautions

Checking the Ink and Maintenance Box Levels
Purchase Epson Ink and Maintenance Box
Refilling the Ink Tank

Replacing the Maintenance Box

Ink Safety Precautions

Ink Handling Precautions
Observe the following when handling the ink:

» Keep ink bottles and the ink tank out of the reach of children. Do not allow children to drink from or
handle the ink bottles and bottle caps.

» Do not tilt or shake an ink bottle after removing its seal; otherwise, ink may leak.

* Be careful not to touch any ink when you handle the ink tank, ink tank cap, and opened ink bottles or
ink bottle caps.

* Ifink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them
immediately with water. If ink gets into your mouth, spit it out immediately. Seek medical advice if
problems persist.

Ink Refilling Precautions

* Use ink bottles with the correct part number for this product.

* Epson's warranties do not extend to any damage caused by the use of third-party ink or ink not
designed for your printer.
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This product requires careful handling of ink. Ink may splatter when the ink tank is filled or refilled with
ink. If ink gets on your clothes or belongings, it may not come off.

Do not open the ink bottle package until you are ready to fill the ink tank. Ink bottles are vacuum
packed to maintain reliability. If you leave an ink bottle unpacked for a long time before using it, print
quality may be affected.

If the ink level is below the lower line on the ink tank, refill the ink soon. Continued use of the product
when the ink level is below the lower line on the ink tank could damage the product.

Epson recommends filling the ink tank to the upper line when the product is not operating.

After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for
at least three hours before using it.

Store ink bottles in a cool, dark place.

Store the ink bottles in the same environment as the product. When storing or transporting an ink
bottle after removing its seal, do not tilt the bottle and do not subject it to impacts or temperature
changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to
keep the ink bottle upright when tightening the cap, and take measures to prevent ink from leaking
when you transport the bottle.

Use the ink bottle before the date printed on the package.
Do not shake or squeeze the ink bottle.

Ink Bottle and Ink Tank Information

To maintain optimum print head performance, some ink is consumed from the ink tank during printing
and when performing maintenance operations, such as cleaning the print head.

The ink bottles may contain recycled materials, but this does not affect product function or
performance.

Parent topic: Refilling Ink and Replacing the Maintenance Box

Checking the Ink and Maintenance Box Levels

Your product and software will let you know when to refill the ink or replace the maintenance box.

Checking the Ink Level on Your Product
Checking the Maintenance Box Level - Windows
Checking the Maintenance Box Level - Mac
Disabling Special Offers with Windows

Parent topic: Refilling Ink and Replacing the Maintenance Box
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Checking the Ink Level on Your Product

To confirm the ink level, visually check the ink level in the product’s ink tank. Make sure the ink level is
above the lowest line on the ink tank.

Caution: If the ink level is below the lower line on the ink tank, fill it to the upper line on the ink tank.
Continued use of the product when the ink level is below the lower line on a tank could damage the
product.

Parent topic: Checking the Ink and Maintenance Box Levels

Related concepts
Purchase Epson Ink and Maintenance Box

Related tasks
Refilling the Ink Tank

Checking the Maintenance Box Level - Windows
You can check your maintenance box level at any time using a utility on your Windows computer.

1. Access the Windows Desktop and double-click the ."hﬁ icon for your product in the right side of the
Windows taskbar, or click the up arrow and double-click !l-‘
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You see a window like this:

W EPSOM Status Menitor 3 -

EPSON "®¥

it is ready to print,

Iric Lewed
To confirm the actual ink remainng, visually chede the ink level in the ink tank of the printer,

Ink Code

Maintenance Boo Service Life

e ——

2. Replace the maintenance box if needed.
Parent topic: Checking the Ink and Maintenance Box Levels

Related concepts
Purchase Epson Ink and Maintenance Box

Related tasks
Replacing the Maintenance Box

Checking the Maintenance Box Level - Mac

You can check your maintenance box level at any time using a utility on your Mac.
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1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select EPSON Status Monitor.
You see a window like this:

Epson Printer Wikity 4

EPSON

% EPSOM Status Monitor
Iris L]

To confirm the actual ink remaining, wisually check the ink level in the ink tank of the
prinker.

Hack

Mynienancg Box Senece Lig

Update OK

3. Do the following as necessary:
* You can update the maintenance box status by clicking Update.
* Replace the maintenance box if needed.

Parent topic: Checking the Ink and Maintenance Box Levels

Related concepts
Purchase Epson Ink and Maintenance Box

Related tasks
Replacing the Maintenance Box
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Disabling Special Offers with Windows
You can disable special offers messages from Epson using a utility on your Windows computer.

o
1. Access the Windows Desktop and right-click the ## icorlfor your product in the right side of the

Windows taskbar, or click the up arrow and right-click 2. Select Monitoring Preferences.
You see this window:

Manitoring Preferences ? *
Select Notification
Event Soareen Mobification La
B Error On
O Communication Error off
& Printer Selection Error on
O Irk Low Off o
Default

Select Shortout Ioon
] Register the shortout icon to the taskbar

Droubde-cicking the Shortout Icon
opene the Printer Status Window.

[] Bow monitoring of shared printers

[ Display Epson Offers
[[] 5hare my usage information with Epson

o] [ o =

2. Todisable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Checking the Ink and Maintenance Box Levels
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Purchase Epson Ink and Maintenance Box

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales),
epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from
an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S.
or 800-807-7766 in Canada.

Note: Epson's warranties do not extend to any damage caused by the use of third-party ink or ink not
designed for your printer.

The included ink bottle must be used for printer setup and is not for resale. The printer ships with a full
ink bottle and part of the ink from the bottle is used to charge the print head. Yields vary considerably
based on images printed, print settings, paper type, frequency of use and temperature.

Check the ink level in your product frequently, and refill the ink tank if necessary.

Ink Bottle and Maintenance Box Part Numbers
Parent topic: Refilling Ink and Replacing the Maintenance Box

Ink Bottle and Maintenance Box Part Numbers

Use these part numbers when you order or purchase new ink bottles or a new maintenance box. Use the
ink by the date printed on the package.

Ink color Part number

Black 532

Maintenance box part number: T04D100
Parent topic: Purchase Epson Ink and Maintenance Box

Refilling the Ink Tank

Make sure you have a new ink bottle handy and have read the ink safety precautions before you begin.
You can continue to use the product even if the ink tank is not filled all the way.

Caution: Wear disposable gloves while refilling the ink tank to avoid staining your hands. If ink spills,
wipe it off immediately with a damp towel to avoid permanent stains. If ink gets on your clothes or
belongings, it may not come off.
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1. Open the ink tank cover.
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3. Hold the ink bottle upright and slowly turn the bottle cap to remove it.

e

Caution: Do not shake or squeeze the bottle. Do not touch the top of the bottle after its cap is
removed.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out immediately. Seek medical
advice if problems persist. Keep the ink bottles out of the reach of children and do not drink the ink.
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4. Position the top of the ink bottle along the slot in front of the filling port, then slowly stand the bottle
up to insert it.
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5. Wait for the ink to fill the tank. Ink flows into the tank and stops automatically when the ink is filled to
the upper line.

Note: If ink does not flow from the bottle, lift and reinsert the bottle.

111



6. When the ink tank is full, remove the ink bottle and securely close the ink tank cap.

L

Note: If any ink remains in the bottle, replace the bottle cap and tighten it. Store the bottle upright for
later use.

7. Close the ink tank cover.

8. Ifthe 0 ink light is flashing, press the & stop button.
Parent topic: Refilling Ink and Replacing the Maintenance Box

Related concepts
Purchase Epson Ink and Maintenance Box

Replacing the Maintenance Box
Make sure you have a new maintenance box before you begin.
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Observe the following when replacing the maintenance box:

Do not drop the maintenance box or subject it to strong shocks.
Do not replace the maintenance box during printing; otherwise, ink may leak.
Do not remove the maintenance box or its cover except when replacing the maintenance box.

If you cannot replace the cover, the maintenance box may not be installed correctly. Remove and
reinstall the maintenance box.

Do not tilt the used maintenance box until after it is sealed in the plastic bag or ink may leak.
Do not touch the openings in the maintenance box or you may get ink on you.
Do not reuse a maintenance box that has been removed and left uninstalled for more than a week.
Keep the maintenance box away from direct sunlight.
Do not store the maintenance box in high or freezing temperatures.
Remove the new maintenance box from its package.

Caution: Do not touch the green chip on the maintenance box. Doing so may prevent normal
operation and printing.

Using a flat-tipped screwdriver, loosen the screw on the maintenance box cover and slide off the
cover as shown.
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3. Remove the used maintenance box.

Note: Do not tilt the used maintenance box until after it is sealed in the plastic bag or ink may leak.

Caution: Do not touch the maintenance box areas shown below; otherwise, ink may leak.

MY 7

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out immediately. Keep the
maintenance box out of the reach of children and do not drink the ink.
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4. Place the used maintenance box in the plastic bag that came with the new maintenance box. Seal
the bag and dispose of it carefully.

5. Insert the new maintenance box and push it all the way in.

NG

72
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6. Reattach the maintenance box cover and tighten the screw.

Parent topic: Refilling Ink and Replacing the Maintenance Box

116



Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.

If running these utilities does not solve the problem, you may need to run a Power Cleaning or clean the
paper path.

Print Head Maintenance

Print Head Alignment

Cleaning the Paper Path

Checking the Number of Sheets

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if the ink level has reached the lower line on the ink tank, and may
not be able to clean it when the ink level in the tank is low. You must refill the ink tank first.

If you still see white or dark lines or gaps in your printouts, even after cleaning the print head several
times, you can run a Power Cleaning.

Print Head Nozzle Check
Print Head Cleaning
Power Cleaning

Parent topic: Adjusting Print Quality

Related concepts
Power Cleaning

Related tasks
Refilling the Ink Tank

Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.
Checking the Nozzles Using the Product Buttons
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Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Buttons

You can check the print head nozzles using the buttons on your product.

1.

2.
3.
4

Press the O power button to turn the product off.

Load a few sheets of plain paper in the paper cassette.

Hold down the @ stop button and press the ¢ power button to turn the product on.
When the product turns on, release both buttons.

The product begins printing a nozzle check pattern.
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5. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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6. Ifthere are no gaps, the print head is clean and you can continue printing.
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If there are gaps or the pattern is faint, clean the print head. If almost the entire pattern is missing,
see the link below for instructions on performing a Power Cleaning.

Parent topic: Print Head Nozzle Check

Related concepts
Power Cleaning

Related tasks
Cleaning the Print Head Using the Product Buttons
Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Load a few sheets of plain paper in the paper cassette.
2. Do one of the following:

* Windows: Access the Windows Desktop and right-click the & icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click T )

* Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

3. Select Nozzle Check.
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You see a window like this:

#] Mozzle Check *

To perform a nozzle chedk, maks sure that the printer i on and
connected to the computer, Also make sure that A4 or Letter size plan
paper i loaded in the paper cassette. Chak [Print] to print a nozze
check pattern or dick [Cancel] to quit.

Click Print.
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5. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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6. Ifthere are no gaps, click Finish.
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If there are gaps or the pattern is faint, clean the print head. If almost the entire pattern is missing,
see the link below for instructions on performing a Power Cleaning.

Parent topic: Print Head Nozzle Check

Related concepts
Power Cleaning

Related tasks
Cleaning the Print Head Using a Computer Utility

Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if the ink level has reached the lower line on the ink tank, and may
not be able to clean it when the ink level in the tank is low. You must refill the ink tank first.

Cleaning the Print Head Using the Product Buttons
Cleaning the Print Head Using a Computer Utility

Parent topic: Print Head Maintenance
Cleaning the Print Head Using the Product Buttons
You can clean the print head using the buttons on your product.
1. Make sure no product lights are indicating errors.
2. Load afew sheets of plain paper in the paper cassette.
3. Hold down the & stop button for seconds to start the cleaning cycle.

The O power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Caution: Never turn off the product or open the printer cover during a cleaning cycle or you may not
be able to print.

4. Run a nozzle check to confirm that the print head is clean.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least six hours. Then try cleaning the print head again. If quality still does not improve, run a Power
Cleaning. If there is still no improvement, contact Epson support.
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Parent topic: Print Head Cleaning

Related concepts
Power Cleaning

Related tasks
Checking the Nozzles Using the Product Buttons
Refilling the Ink Tank

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.
1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the paper cassette.
3. Do one of the following:

* Windows: Access the Windows Desktop and right-click the % icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click - F

* Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Head Cleaning.
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You see a window like this:

4 Head Cleaning w

\Qt Chick [Start] to dean the print head nozzles. Because deaning
consumes some ink, only dean the print head when faint areas or
QARS BOPEar in your printout, Use the Norde Check” utlity first to
confirm that the print bead needs to be deaned.

=

5. Click Start to begin the cleaning cycle.

The O power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Caution: Never turn off the product or open the printer cover during a cleaning cycle or you may not
be able to print.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.

125



7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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* If there are no gaps, click Finish.
+ If there are gaps or the pattern is faint, click Clean to clean the print head again.
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+ If alImost the entire pattern is missing, click Finish and perform a Power Cleaning.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least six hours. Then try cleaning the print head again. If quality still does not improve, run a Power
Cleaning. If there is still no improvement, contact Epson support.

Parent topic: Print Head Cleaning

Related concepts
Power Cleaning

Related tasks
Checking the Nozzles Using a Computer Utility
Refilling the Ink Tank

Power Cleaning

If you still see white or dark lines or missing nozzles in your printouts, even after cleaning the print head
several times, you can run a Power Cleaning.

If you do not see improvement after running a Power Cleaning, turn off the product and wait at least 12
hours before running another Power Cleaning.

Caution: Running a Power Cleaning consumes a lot of ink, so you should run it only if necessary. Make
sure the ink tank is at least one-third full before running a Power Cleaning, or it may damage the product.
Power Cleaning Using a Computer Utility

Parent topic: Print Head Maintenance

Related concepts
Print Head Cleaning

Power Cleaning Using a Computer Utility
You can run a Power Cleaning using a utility on your Windows or Mac computer.

Note: After running a Power Cleaning, you must turn off the product and wait at least 12 hours before
running another Power Cleaning.

1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the paper cassette.
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3. Do one of the following:

* Windows: Access the Windows Desktop and right-click the !1-‘ icon for your product in the right

side of the Windows taskbar, or click the up arrow and right-click !U Select Printer Settings and
click the Maintenance tab.

* Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Power Cleaning.
You see a window like this:

€ig Power Cleaning w

Print head deaning may not improve the print quality in the fallowing
situations.

Consider performing Power Cleaning if:
- fou performed the nozzle chedk and head deaning several times and

then waited for at least & hours without printing, but print quality still
did not improve.

Mext Cance|

5. Follow the on-screen instructions to run a Power Cleaning.
6. When Power Cleaning is finished, run a nozzle check.
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If the print quality did not improve, turn off the product and wait at least 12 hours before running another
Power Cleaning.

If the print quality does not improve after running the Power Cleaning utility multiple times, contact Epson
for support.

Parent topic: Power Cleaning

Related concepts
Print Head Cleaning

Related tasks
Refilling the Ink Tank

Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using a Computer Utility
Parent topic: Adjusting Print Quality

Aligning the Print Head Using a Computer Utility
You can align the print head using a utility on your Windows or Mac computer.
1. Make sure no product lights are indicating errors.
2. Load afew sheets of plain paper in the product.
3. Do one of the following:

* Windows: Access the Windows Desktop and right-click the & icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click T )

* Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Print Head Alignment.
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5. Click Next, then click Print to print an alignment sheet.
Note: Do not cancel printing while you are printing a head alignment pattern.

You see a window like this:

a-A Print Head Alignment x

Look at the alignment sheet,

A A Find the pattern without a misaligned vertical ine in sets =1 and =2 and
select the pattern number from the list below. Select a pattern for all
sets, then dick [Next >].

If every pattern contains a misaligned vertical ine, select the pattern
with the least misaligned vertical line and dick [Realignment].

TENE I

S =

6. Check the printed pattern and follow the instructions on the screen to choose the number of the best
printed pattern for each set.

 After choosing a pattern number, click Next.

* If no patterns are aligned in one or more of the sets, choose the closest one in each set and click
Realignment. Then print another alignment sheet and check it.

Note: Click Skip (where available) if you want to skip a particular alignment sheet.

7. When you are done, click Finish.
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Parent topic: Print Head Alignment

Cleaning the Paper Path

If you see ink on the back of a printout, you can clean the paper path to remove any excess ink.

1.
2.
3.

No o b

Make sure no product lights are indicating errors.
Load a few sheets of plain paper in the product.
Do one of the following:

* Windows: Access the Windows Desktop and right-click the % icon for your product in the right

side of the Windows taskbar, or click the up arrow and right-click %7 Select Printer Settings and
click the Maintenance tab.

* In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and
select Open Printer Utility.

Select Paper Guide Cleaning.

Follow the on-screen instructions to feed paper through the product.
Check the back of the ejected paper to see if it is clean.

Repeat as necessary until the paper comes out clean.

Parent topic: Adjusting Print Quality

Related tasks
Cleaning the Paper Rollers

Checking the Number of Sheets

You can view an option that displays the number of sheets of paper that have fed through the product.

Note: You can also view the number of sheets of paper fed through the product by printing a nozzle
check.

Checking the Sheet Counter - Windows
Checking the Sheet Counter - Mac

Parent topic: Adjusting Print Quality
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Checking the Sheet Counter - Windows

You can check the number of sheets of paper that have fed through the product by checking the sheet
counter.

1. Access the Windows Desktop and right-click the !1-1 icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.

3. Click the Maintenance tab.
Select Printer and Option Information.
You see this window:
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5. After checking the number of sheets fed into the printer, click OK to close the window.
Note: The number of sheets is displayed only when Epson Status Monitor 3 is enabled.

Parent topic: Checking the Number of Sheets

Checking the Sheet Counter - Mac

You can check the number of sheets of paper that have fed through the product by checking the sheet
counter.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.
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2. Select Printer and Option Information.
You see this window:

| ] Epson Printer Utility 4

EPSON esox
#.

Mumber of Sheets of Paper Fed

T shot

Printer and Option Information

3. After checking the number of sheets fed into the printer, click OK to close the window.
Parent topic: Checking the Number of Sheets
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Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Cleaning the Print Head Path
Cleaning the Paper Rollers
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.
Close the printer cover and front cover when you are not using the product to protect it from dust.

Caution: Do not use a hard brush, benzene, alcohol, or paint thinner to clean the product or you may
damage it. Do not place anything on top of the cover or use the cover as a writing surface, or it could get
permanently scratched. Do not use oil or other lubricants inside the product or let water get inside.

Turn off the product.
Unplug the power cable.

Disconnect any connected cables.
Remove all the paper.

ok~ wbd -~

Clean the outer case with a soft, dry cloth. Do not use any liquid or chemical cleansers.
Parent topic: Cleaning and Transporting Your Product

Cleaning the Print Head Path

If the print quality has not improved after aligning the print head and cleaning the paper guide, the print
head path inside the product may be smeared with ink.

To clean the print head path, use the following:

+ Several cotton swabs

» Yacup (59 ml) water containing 2 to 3 drops of mild dish detergent
+ A small flashlight

Caution: Do not use any other liquid to clean the print head path or you may damage your product.
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Turn off the product.
Unplug the power cable.
Disconnect any connected cables.

o bd -~

Open the printer cover.

1 Translucent film
2 Print head rail

Caution: Do not touch the flat white cable or the print head rail; otherwise, you may not be able to
print. Do not wipe off the grease on the rail.
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6. Moisten a cotton swab with the water and detergent mixture and squeeze out any excess moisture.
Use it to lightly wipe ink off the translucent film.

Caution: Do not press too hard on the film or you may dislocate the anchor springs and damage the
product.

7. Use a new, dry cotton swab to dry the translucent film.

8. Repeat steps 6 and 7 as necessary to clean all ink smears.
9. When the translucent film is dry, close the printer cover.

10. Plug in the power cable and reconnect any interface cables.
Parent topic: Cleaning and Transporting Your Product

Cleaning the Paper Rollers

If you encounter repeated paper feed issues from the cassette, clean the paper rollers inside the
product.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
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4. Slide out the paper cassette and remove the paper.

5. Open the ink tank cover and make sure that the ink tank cap is securely closed.

<

L
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6. Place the product on its side with the ink tank on the bottom.

Warning: Be careful not to trap your fingers under the product.

7. Use a soft, moist cloth to clean the paper rollers, as shown. Rotate the rollers to clean them
thoroughly.

8. Return the product to its normal position.

Caution: Do not leave the product on its side for an extended period of time.
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9. Replace the paper, slide in the paper cassette, and connect the power cord and any interface
cables.

Parent topic: Cleaning and Transporting Your Product

Transporting Your Product

If you need to store your product or transport it some distance, prepare it for transportation as described
here.

Caution: During transportation and storage, follow these guidelines:
* Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

» When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do not
subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink bottle
is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and take
measures to prevent ink from leaking when transporting the ink bottles.

* Do not put opened ink bottles in the box with the product.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

Turn off the product.

2. Open the printer cover and check to see if the print head is in the far right position (the home
position). If not, turn on the product, wait for the print head to move to the far right, then turn the
product off again.

3. Secure the print head to the case with tape.

Caution: Do not place tape on the white flat cable or ink tubes inside the product; otherwise, you
may damage your product.

4. Remove all the paper from the product.
5. Unplug the power cable.
6. Disconnect any connected cables.
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7. Open the ink tank cover and make sure that the ink tank cap is installed securely.
é%®\
J

10. Place the product in its original packaging materials, if possible, or use equivalent cushioning around
the product.

L

8. Close the ink tank cover.
9. Place the product in a plastic bag.

Be sure to remove the tape from the print head before turning on your product. If print quality has
declined when you print again, clean and align the print head.

Parent topic: Cleaning and Transporting Your Product

Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates

Product Light Status

Running a Product Check

Solving Setup Problems

Solving Network Problems

Solving Paper Problems

Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems

Uninstall Your Product Software

Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software.
Visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and
select your product.

* Windows: Your printer software automatically checks for updates. You can also manually update the
software by selecting Software Update here:
» Access the Windows Desktop and right-clicking the % icon for your product in the right side of the
Windows taskbar, or clicking the up arrow and right-clicking Bui
» On the Maintenance tab in the printer settings window

You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

» 0OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

* macOS 10.12.x, 10.13.x, or 10.14.x: You can manually update the software by opening the App
Store, selecting Updates, searching for a software update option for Epson Software, and selecting
Update.
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Parent topic: Solving Problems

Related tasks
Changing Automatic Update Options

Product Light Status

You can often diagnose problems with your product by checking its lights.

FE 0O [
®@ 60 0O
1 Opower light
2 ¥ Wi-Filight
3 [® Wi-FiDirect light
4  Oink light
5 [ paper light
Light status Condition/solution
The O power light is on The product is turned on.
The & Wi-Fi light is on The product is connected to a wireless network.
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Light status

Condition/solution

The [F Wi-Fi Direct light is on

The product is connected to a device using Wi-Fi Direct.

The O power light is flashing

The product is busy. Wait for the & power light to stop flashing before
turning off the product.

The & Wi-Fi and [& Wi-Fi
Direct lights are flashing

A Wi-Fi connection error has occurred. Press the Wi-Fi button to clear
the error and try again.

The O ink light is on

Initial ink charging or ink refilling may not be complete. See the Start
Here sheet for instructions on initial ink charging.

The 0 ink light is flashing

The product is low on ink or the maintenance box is nearing the end of
its service life. If a message to continue printing appears on your
computer, press the & stop button to continue printing.

The [J paper light is on

No paper is loaded or the loaded paper size does not match the print
setting. Load the correct size paper in the product and press the & stop
button to clear the error.

The [J paper light is flashing

Paper is jammed in the product or protective material remains inside.
Remove the jammed paper or any protective material and press the
@ stop button to clear the error.

The O ink light is on
The [J paper light is on

The product was not turned off correctly. Press the & stop button to
clear the error, then run a nozzle check and cancel any pending print
jobs. Always use the O power button to turn off the product.

The 0 ink and [J paper lights
are flashing simultaneously

The printer cover is open or the output selector is in the incorrect
position. Close the printer cover or change the output selector's
position.

The 0 ink and [J paper lights
are flashing alternately

The maintenance box is at the end of its service life, not recognized, or
installed incorrectly. Replace the maintenance box or make sure it is
installed correctly.

All lights are flashing

Paper or protective material is stuck inside the product. Open the front
cover and remove any jammed paper or protective materials. Turn the
product off and then back on again. If the error continues, contact
Epson for support.

All lights except the O power
light are flashing

An error has occurred during firmware updating. Connect your product
using a USB cable and try updating the firmware again. If the error
continues, contact Epson for support.
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Parent topic: Solving Problems

Related references

Paper Jam Problems in the Front of the Product
Paper Jam Problems Inside the Product

Paper Jam Problems in the Rear Cover

Where to Get Help

Related tasks
Checking for Software Updates

Related topics
Loading Paper
Refilling Ink and Replacing the Maintenance Box

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Press the O power button to turn the product off.
2. Load a few sheets of plain paper in the product.
3. Hold down the & stop button and press the () power button to turn the product on.
4. When the product turns on, release both buttons.
The product begins printing a nozzle check pattern.

Note: It can take a few seconds for the nozzle check to start printing. If the nozzle check does not
start printing after a few seconds, make sure there is paper loaded in the printer.
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5. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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6. Do one of the following, depending on the results of the product check:

+ If the page prints and the nozzle check pattern is complete, the product is operating properly. Any
operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

+ If the page prints but the nozzle check pattern has gaps, clean or align the print head.

+ If the page does not print, the product may have a problem. Check the other solutions in this
manual. If they do not work, contact Epson.

Parent topic: Solving Problems

Related concepts

Print Head Nozzle Check

Print Head Cleaning

Print Head Alignment

Uninstall Your Product Software

Related references
Where to Get Help

Related topics
Loading Paper

Solving Setup Problems
Check these sections if you have problems while setting up your product.

Product Does Not Turn On or Off
Noise After Filling the Ink
Software Installation Problems

Parent topic: Solving Problems

Product Does Not Turn On or Off

If you cannot turn the product on or off, try these solutions:

* If you cannot turn on your product, make sure the power cord is securely connected and hold down
the power button a little longer.
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« If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off
your product, unplug the power cord, plug the power cord back in, then turn your product on and off
again using the power button.

Parent topic: Solving Setup Problems

Noise After Filling the Ink

If you hear noises from your product after filling the ink tank with ink, check these solutions:

» The first time you fill the tank with ink, the product must charge its print head. Wait until charging
finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on. Your product is finished charging the print head when the O power light stops flashing.

+ If the product's print head stops moving or making noise, and the charging process has not finished,
turn off your product. Turn it back on and check to see if charging is still in progress. If it is still in
progress, contact Epson for help.

Parent topic: Solving Setup Problems

Software Installation Problems
If you have problems while installing your product software, try these solutions:

» Make sure your product is turned on and any necessary cables are securely connected at both ends. If
you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

» Close any other programs, including screen savers and virus protection software, and install your
product software again.

* In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

 If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your system administrator.

+ If you are printing over a network, make sure your product is set up properly on the network.
Parent topic: Solving Setup Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements
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Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

Network Software Cannot Find Product on a Network

Product Cannot Connect to a Wireless Router or Access Point
Cannot Print Over a Network

Wireless Network Connection is Unstable on a Mac

Parent topic: Solving Problems

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:

Make sure your product is turned on and connected to your network. Verify the connection using your
product control panel.

Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-
ASCII characters.

Print a network connection report and check the codes and messages on the report to help determine
the cause of the problem.

Make sure your product is not connected to a guest network.

If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.

2. Windows only: Uninstall your product software.

3. Restart your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router, so note the next step before restarting it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

If you have replaced your router, reinstall your product software to connect to the new router.
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Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

» Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing detection of your device over the network. See your router or access point documentation
for instructions on disabling the Privacy Separator function.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related tasks
Printing a Network Status Sheet
Printing a Network Connection Report

Related topics
Wi-Fi or Wired Networking

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

« If you are connecting the product via Wi-Fi Protected Setup (WPS) and the & Wi-Fi light on your
product is not solid green, make sure you press the Wi-Fi button on the product within 2 minutes of
pressing the WPS button on your router. Hold down the Wi-Fi button on the product for 5 seconds or
until the & Wi-Fi and [& Wi-Fi Direct lights start blinking.

» Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

» Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.
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Print a network connection report and check the codes and messages on the report to help determine
the cause of the problem.

You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router.

Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

If you cannot connect your product to a device using Wi-Fi Direct, you may have exceeded the
maximum number of devices connected to your product (4). Print a network status sheet or access
Web Config on the browser for your device and check the number of connected devices. If 4 devices
are already connected, disconnect a device by deleting the product's SSID from the Wi-Fi screen of
that device. If fewer than 4 devices are connected, check the accuracy of your other network settings,
move your device closer to your product, and try connecting again.

If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

Parent topic: Solving Network Problems

Related concepts
Wi-Fi Protected Setup (WPS)

Related tasks

Printing a Network Status Sheet
Printing a Network Connection Report
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Related topics
Wi-Fi or Wired Networking

Cannot Print Over a Network
If you cannot print over a network, try these solutions:

Make sure that your product is turned on.
Make sure you install your product's network software as described in your product documentation.

Print a network status sheet and verify that the network settings are correct. If the network status is
Disconnected, check any cable connections and turn your product off and then on again.

Print a network connection report and check the codes and messages on the report to help determine
the cause of the problem.

If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your
network does not assign IP addresses using DHCP, set the IP address manually.

Make sure your computer and product are both using the same wireless network.

If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place
your product closer to your router or access point. Avoid placing your product near a microwave oven,
2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router.

Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the & Wi-Fi light on your
product is not solid green, make sure you press the Wi-Fi button on the product within 2 minutes of
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pressing the WPS button on your router. Hold down the Wi-Fi button on the product for 5 seconds or
until the & Wi-Fi and [& Wi-Fi Direct lights start blinking.

* If you are connecting the product via EpsonNet Setup and the & Wi-Fi light on your product is not
solid green, make sure your product software was installed correctly. If necessary, reinstall your
software.

Parent topic: Solving Network Problems

Related tasks
Printing a Network Status Sheet
Printing a Network Connection Report

Related topics
Wi-Fi or Wired Networking

Wireless Network Connection is Unstable on a Mac

If you connected a device to a USB 3.0 port on your Mac, you may experience wireless network
interference between your product and your Mac.

If you cannot connect to your product over the wireless network or the connection becomes unstable,
move the device connected to your Mac USB 3.0 port further away from your Mac.

Parent topic: Solving Network Problems

Solving Paper Problems

Check these sections if you have problems using paper with your product.

Paper Feeding Problems

Paper Jam Problems in the Front of the Product
Paper Jam Problems Inside the Product

Paper Jam Problems in the Rear Cover

Paper Ejection Problems

Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:

« If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust
the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette. Make sure to load only one sheet at a time in the rear feed slot.
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* Place the product on a flat surface and operate it in the recommended environmental conditions.
* Be sure to insert the paper cassette all the way into your product.
» If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
* Do not load more than the recommended number of sheets.
» Make sure your paper meets the specifications for your product.
 If paper jams when you print on both sides of the paper, try loading fewer sheets.
* Make sure the paper size and paper type settings are correct for the paper source.
* Run the paper guide cleaning utility to clean the paper path.
» Clean the roller inside the printer to remove any dust on the paper path.
» For best results, follow these guidelines:
» Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
» Load paper in the cassette printable side down.
» Do not load binder paper with holes in the cassette.
» Follow any special loading instructions that came with the paper.
Parent topic: Solving Paper Problems

Related references

Paper Specifications

Paper Loading Capacity
Double-sided Printing Capacity
Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Cleaning the Paper Path

Cleaning the Paper Rollers

Related topics

Loading Paper

Paper Jam Problems in the Front of the Product
If paper has jammed in the front of the product, follow the steps here.
1. Cancel the print job, if necessary.
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2. Open the front cover.

7
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5. Raise the output selector.
6. Close the front cover.
Parent topic: Solving Paper Problems

Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Rear Cover

Related tasks
Cancelling Printing Using a Product Button

Related topics
Loading Paper

Paper Jam Problems Inside the Product
If paper has jammed inside the product, follow the steps here.

Warning: Never touch the buttons on the control panel while your hand is inside the product. If the
product starts operating, it may cause an injury. Do not touch any protruding parts inside the product.

1. Cancel the print job, if necessary.
2. Lift the printer cover.
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3. Remove any jammed paper from inside the product.
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4. Close the printer cover until it clicks into place.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems in the Front of the Product
Paper Jam Problems in the Rear Cover

Related tasks
Cancelling Printing Using a Product Button

Related topics
Loading Paper

Paper Jam Problems in the Rear Cover
If paper has jammed in the rear cover, follow the steps here.
1. Cancel the print job, if necessary.
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2. Press the buttons to release the rear cover and remove the cover from your product.

3. Carefully remove any jammed paper from inside the product.
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4. Remove any jammed paper from the rear cover.

5. Press the buttons and reattach the rear cover.
Parent topic: Solving Paper Problems

Related references
Paper Jam Problems in the Front of the Product
Paper Jam Problems Inside the Product

Related tasks
Cancelling Printing Using a Product Button

Related topics
Loading Paper

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:

+ If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.
Select the correct paper size when you reprint.

« If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select
the correct paper type setting when you reprint.

Parent topic: Solving Paper Problems
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Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Cancelling Printing Using a Product Button

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow

Parent topic: Solving Problems

Nothing Prints

If you have sent a print job and nothing prints, try these solutions:

Make sure your product is turned on and connected to your computer.
Make sure any interface cables are connected securely at both ends.

If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,
connect your product directly to your computer instead of the hub.

If the printer cannot print using a USB connection, disconnect the USB cable from the computer, right-
click on the printer icon displayed on the computer, and select Remove Device. Then connect the
USB cable to the computer and try a test print.

Make sure the printer status is not offline or pending.

Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. Print the image at a lower
resolution or if necessary, increase your system's memory.

In Windows, make sure your product is selected as the default printer and the printer port setting
matches the printer connection port.

In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

On a Mac, make sure the printer is added to the printer list and the printer is not paused.
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* Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Problems Printing from a Computer

Related references
Windows System Requirements
Mac System Requirements

Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:

1. Do one of the following:
* Windows 10: CIickﬂ and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printing preferences.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select Printing Preferences, and select
your product name again if necessary.

* Windows 7: Click E]' and select Devices and Printers. Right-click your product name, select
Printing Preferences, and select your product name again if necessary.

* Windows Vista: Click E]' select Control Panel, and click Printer under Hardware and Sound.
Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

Click the Maintenance tab.

Click the Extended Settings button.

Select Enable EPSON Status Monitor 3 and click OK.

Click the Monitoring Preferences button.

Click the checkbox for the option that adds the shortcut icon to the taskbar.
Click OK to close the open program windows.

No g bk DN

Parent topic: Solving Problems Printing from a Computer
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Printing is Slow
If printing becomes slow, try these solutions:

Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

If you are using Windows 7, close the Devices and Printers window before you print.
On a Mac, make sure you download and install the Epson printer driver.

Make sure Quiet Mode is turned off.

Clear space on your hard drive or run a defragmentation utility to free up existing space.
Close any programs you are not using when you print.

If your product is connected to a USB hub, connect it directly to your computer instead.

If printing becomes slower after printing continuously for a long time, the product may have
automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

If you are printing over a wireless network, factors such as interference, network traffic, or weak signal
strength may affect your printing speed.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

For the fastest printing, select the following settings in your product software:

Make sure the paper type setting matches the type of paper you loaded.
Turn on any high speed settings in your product software.
Select a lower print quality setting.

Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,
and select the following settings:

+ Always Spool RAW Datatype
* Page Rendering Mode
* Print as Bitmap
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* Windows: Select Printer Properties, click the More Options tab, and make sure the High Speed
setting is enabled.

* Mac: Select System Preferences, select Printers & Scanners, and select your product. Select
Options & Supplies, select Options (or Driver), and enable the High Speed Printing setting.

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click EI' and select Computer or My Computer. Double-click the C: drive and open these folders:
ProgramData > EPSON > PRINTER.

Note: If you do not see the ProgramData folder, open the Organize menu and select Folder and
search options. In the window that appears, click the View tab, select Show hidden files, folders,
and drives in the Advanced settings list, and click OK.

2. Right-click the EPAUDFO01.AUD file and select Delete.
3. Restart your computer and try printing again.
Parent topic: Solving Problems Printing from a Computer

Related references
Paper or Media Type Settings - Printing Software

Related tasks

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Solving Page Layout and Content Problems

Check these sections if you have problems with the layout or content of your printed pages.

Inverted Image

Too Many Copies Print

Blank Pages Print

Incorrect Margins on Printout
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems
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Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
» Turn off any mirror or inversion settings in your printing application.

» Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer
software. (This option has different names, depending on your operating system version.)

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Print Layout Options - Mac

Too Many Copies Print

Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
» Make sure you selected the correct paper size settings in your printing program and printer software.

 If a blank page exists in a document you are printing and you want to skip printing it, select the Skip
Blank Page setting in your printer software, if available.

* Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if
necessary.

» Make sure your product is selected as the printer in your printing program.
* You may need to refill the ink. Visually check the ink level.
Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
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Related tasks

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
* Make sure you selected the correct paper size settings in your printing program and printer software.
* Make sure you selected the correct margins for your paper size in your printing program.
» Make sure your paper is positioned correctly for feeding into the product.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Related topics
Loading Paper

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
* Make sure any cables are securely connected at both ends.

* In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

« If your product is connected to a USB hub, connect it directly to your computer instead.

« If your computer entered sleep mode the last time you printed, the next print job after your computer
exits sleep mode may contain garbled characters. Print your document again.

« Ifincorrect characters still appear in your prints, try connecting your product using a different cable.

» Make sure you are using the printer software for this product. Check the product name at the top of the
driver window.

Parent topic: Solving Page Layout and Content Problems
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Related tasks
Selecting Extended Settings - Windows

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:

* Make sure you selected the correct paper size and layout settings in your printing program and printer
software.

» Make sure your paper is positioned correctly for feeding into the printer.

» Slide the edge guides against the edges of the paper.

* Make sure you selected the correct margins for your paper size in your printing program.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows

Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac

Selecting Print Layout Options - Mac

Related topics
Loading Paper

Slanted Printout
If your printouts are slanted, try these solutions:
» Slide the edge guides against the edges of the paper.
« Select a higher print quality setting in your printer software.
» Turn off any high speed settings in your product software.
* Align the print head.
* Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Alignment
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Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Related topics
Loading Paper

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

White or Dark Lines in Printout
Blurry or Smeared Printout

Faint Printout or Printout Has Gaps
Grainy Printout

Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

» Make sure the paper type setting matches the type of paper you loaded.

» Make sure you loaded the printable side of the paper correctly for your product.
» Turn off any high speed settings in your product software.

* Align the print head.

+ Adjust the print quality in the product software.

» When vertical banding appears or the paper is smeared, clean the paper path.
* You may need to refill the ink. Visually check the ink level.

+ If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

Parent topic: Solving Print Quality Problems
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Related concepts

Print Head Nozzle Check

Print Head Cleaning

Print Head Alignment

Power Cleaning

Related tasks

Cleaning the Paper Path

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Related topics
Loading Paper
Refilling Ink and Replacing the Maintenance Box

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:

Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.

Use a support sheet with special paper, or load special paper one sheet at a time.

Make sure your paper meets the specifications for your product.

Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.

Make sure the paper type setting in your product software matches the type of paper you loaded.

If you are printing on letterhead paper, make sure the paper size setting matches the size of paper you
loaded. If you select a paper size that is too large for the paper you loaded, the product may print
beyond the edges of the paper and cause ink to smear.

Make sure you loaded the printable side of the paper correctly for your product.

If you are printing on thick paper or envelopes, make sure you select the appropriate settings. In
Windows, you can also try selecting Short Grain Paper in Extended Settings.

If you are printing on thick paper or envelopes, make sure you select the appropriate settings.
Turn off any high speed settings in your product software.

If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily
saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Make sure the ink has dried before reloading the paper to print on the other side. Adjust the density
and/or ink drying time settings.
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* Theink level may be low and you may need to refill the ink. Visually check the ink level.

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

» Align the print head.
» Adjust the print quality in the product software.
» Clean the paper path.

* If you printed when the ink level was too low to be seen in the ink tank window, refill the ink tank to the
upper line and run the Power Cleaning utility. Then run a nozzle check to see if print quality has
improved.

+ If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Power Cleaning

Related references

Paper Specifications

Related tasks

Cleaning the Paper Path

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac

Related topics

Loading Paper

Refilling Ink and Replacing the Maintenance Box
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Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* The ink level may be low. Visually check the ink level.

» Make sure the paper type setting matches the type of paper you loaded.

* Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
» Align the print head.

» Adjust the print quality in the product software.

* Clean the paper path.

 If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check

Print Head Cleaning

Print Head Alignment

Power Cleaning

Related tasks

Cleaning the Paper Path

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Related topics

Loading Paper

Refilling Ink and Replacing the Maintenance Box
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Grainy Printout
If your printouts are grainy, try these solutions:

Make sure you loaded the printable side of the paper correctly for your product.
Select a higher print quality setting and turn off any high speed settings in your product software.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

Align the print head.
Adjust the print quality in the product software.

You may need to increase the image resolution or print a smaller size; see your software
documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

If you enlarged the image size in an image-editing program, you need to increase the image resolution
setting to retain a high image quality. Increase the image resolution by the same amount you increase
the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the
image size for printing, change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related tasks
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows

Related topics
Loading Paper
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Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Printing Software - Standard Epson Printer Software - Windows
Uninstalling Product Software - Mac

Parent topic: Solving Problems

Uninstalling Printing Software - Standard Epson Printer Software - Windows
You can uninstall and then re-install your printer software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

* Windows 10: Click E and select k¥4 (Settings) > Apps > Apps & features. Select the program
you want to uninstall and select Uninstall.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
Epson, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

4. Restart your computer, then re-install your software.
Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software
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Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product.

Click Downloads.

Select your operating system, click Utilities, locate the Uninstaller utility, and click Download.
Run the file you downloaded.

Double-click the Uninstaller icon.

o g bk wbd

In the Epson Uninstaller screen, select the checkbox for each software program you want to
uninstall.

Click Uninstall.
Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the — (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product for solutions to common problems. You can
download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your
questions.
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Speak to a Support Representative

Before you call Epson for support, please have the following information ready:
* Product name

* Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem

Then call:

* U.S.:(5662) 276-7202, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific
Time, Saturday

+ Canada: (905) 709-2567, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,
Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.
Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at epson.com (U.S. sales), epson.ca (Canadian sales),
or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller.
To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this
site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements

Paper Specifications

Printable Area Specifications

Ink Specifications

Dimension Specifications

Electrical Specifications
Environmental Specifications
Interface Specifications

Network Interface Specifications
Safety and Approvals Specifications
Safety and Approvals Specifications for Latin America

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 10

* Windows 8.x

* Windows 7

* Windows Vista

* Windows Server 2016

* Windows Server 2012 R2
* Windows Server 2012

* Windows Server 2008 R2
* Windows Server 2008
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* Windows Server 2003 R2
* Windows Server 2003 SP2 or later
Windows Server supports only the printer driver; any additional included software is not supported.

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select
your product, and select Downloads.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
+ macOS 10.14.x
*+ macOS 10.13.x
*+ macOS 10.12.x
+ OS X10.11.x
+ OS X 10.10.x
+ OS X 10.9.x
+ OS X 10.8.x
+ OSX10.7.x
+ 0OSX10.6.8

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select
your product, and select Downloads.

Parent topic: Technical Specifications
Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.
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Single-sheets

Size

Paper types

Weight
Envelopes

Size
Paper types
Weight

A4 (8.3 x 11.7 inches [210 x 297 mm])

A6 (4.1 x 5.8 inches [105 x 148 mm)])

Letter (8.5 x 11 inches [216 x 279 mm])

Legal (8.5 x 14 inches [216 x 356 mm])

8 x 10 inches (203 x 254 mm)

Half Letter (5.5 x 8.5 inches [140 x 216 mm])
Oficio 9 (8.46 x 12.4 inches [215 x 315 mm])
Mexico-Oficio (8.5 x 13.4 inches [216 x 340 mm])
8.5 x 13 inches (216 x 330 mm)

Executive (7.25 x 10.5 inches [184 x 267 mm])
Plain paper

Note: Your product also supports compatible papers distributed by

Epson. See the link at the end of this topic for a list of compatible
Epson papers.

Plain paper: 17 Ib (64 g/m?) to 24 Ib (90 g/m?)

No. 10 (4.1 x 9.5 inches [105 x 241 mm])
Plain paper
20 Ib (75 g/m?) to 24 Ib (90 g/m?)

Parent topic: Technical Specifications

Related references
Compatible Epson Papers
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Printable Area Specifications

Single sheets

2| | —
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1 Top/bottom/left/right margins: 0.12 inch (3 mm) minimum

2 Reduced print quality area/top: 1.81 inches (46 mm) minimum

3  Reduced print quality area/bottom: 1.73 inches (44 mm) minimum

Envelopes
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Right/left margins: 0.12 inch (3 mm) minimum
Top/bottom margins: 0.20 inch (5 mm) minimum
Reduced print quality area/right: 0.95 inch (24 mm) minimum

A WODN -~

Reduced print quality areal/left: 1.81 inches (46 mm) minimum
Parent topic: Technical Specifications
Ink Specifications

Note: Epson's warranties do not extend to any damage caused by the use of third-party ink or ink not
designed for your printer.

The included ink bottle must be used for printer setup and is not for resale. The printer ships with a full
ink bottle and part of the ink from the bottle is used to charge the print head. Yields vary considerably
based on images printed, print settings, paper type, frequency of use and temperature.

Check the ink level in your product frequently, and refill the ink tank if necessary.

Color Black

Ink bottle life Epson recommends using an ink bottle before the date printed on
the package

Temperature Storage: —4 to 104 °F (—20 to 40 °C)

1 month at 104 °F (40 °C)
Ink freezes at 5 °F (—15 °C)
Ink thaws and is usable after 2 hours at 77 °F (25 °C)

Parent topic: Technical Specifications

Related references
Ink Bottle and Maintenance Box Part Numbers

Dimension Specifications

Height Stored: 5.9 inches (151 mm)
Printing: 5.9 inches (151 mm)
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Width Stored: 14.8 inches (375 mm)
Printing: 14.8 inches (375 mm)

Depth Stored: 13.7 inches (347 mm)
Printing: 13.7 inches (347 mm)
Weight Approximately 9.5 Ib (4.3 kg)

(without ink and power cord)
Parent topic: Technical Specifications
Electrical Specifications

Note: Check the label on the product for its voltage.

Power supply rating 100 to 240 V

Rated frequency range 50 to 60 Hz

Rated current 0.5t00.2A

Power consumption Printing: Approximately 14 W (ISO/IEC24712)

Ready mode: Approximately 3.4 W
Sleep mode: Approximately 0.7 W
Power off mode: Approximately 0.2 W

Parent topic: Technical Specifications

Environmental Specifications

Temperature Operating: 50 to 95 °F (10 to 35 °C)
Storage: —4 to 104 °F (—20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity Operating: 20 to 80% RH

(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications
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Interface Specifications

Interface type

Hi-Speed USB

Parent topic: Technical Specifications

Network Interface Specifications

Wi-Fi

Standard
Security

Frequency range

Maximum radio frequency
power transmitted

Coordination modes

Ethernet

Standard

Communication mode

Connector

IEEE 802.11 b/g/n; IEEE 802.11n is available only for the HT20

WPA2-PSK (AES); WPA2 compliant with support for WPA/WPA2
Personal

WEP (64/128 bit)
2.4 GHz
20 dBm (EIRP)

Infrastructure mode
Wi-Fi Direct (Simple AP); not supported for IEEE 802.11b

Note: Wi-Fi Direct Simple AP mode available even if you connect
the product to an Ethernet network.

IEEE802.3i (10BASE-T); use a category 5e or higher STP (Shielded
Twisted Pair) cable

IEEE802.3u (100BASE-TX)

IEEE802.3az (Energy Efficient Ethernet); the connected device
should be IEEE802.3az compliant

Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full
duplex, 100Mbps Half duplex

RJ-45
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Parent topic: Technical Specifications

Safety and Approvals Specifications

United States Safety: UL60950-1
EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
» Manufacturer: Seiko Epson Corporation
+ Type: J26H006

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).

Parent topic: Technical Specifications

Safety and Approvals Specifications for Latin America

Notice for Argentina
WLAN Module

CN G CNC ID: C-20841
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Notice for Mexico

Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause
undesired operation of the device.

Product Model: B632B (M1180)

WLAN Module Model: J26H006

Brand: EPSON

IFT Certification Number: RCPEPJ218-0025

Notice for Paraguay

Imported by:

Fastrax, S.A.

Av. Peru esq. Rio de Janeiro, Barrios Las Mercedes, Asuncion, Paraguay
Imported by:

Sol Control S.R.L.

Av. Gral. Bernardino Caballero 810 esq. Celsa Speratti, Asuncion, Paraguay

Notice for Peru

Product Model: M1180 (B632B)

Brand: EPSON

This product uses the following WLAN module:

WLAN Module Model: J26H006

FCC ID: BKMFBJ26H006

Product Manufacturer: Seiko Epson Corporation

Address: 3-3-5 Owa Suwa-shi, Nagano-Ken 392-8502, Japan
Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this
site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions

FCC Compliance Statement

Binding Arbitration and Class Waiver
Trademarks

Copyright Notice

Important Safety Instructions

Before using your Epson product, read and follow these safety instructions.

General Printer Safety Instructions
Wireless Connection Safety Instructions

Parent topic: Notices

General Printer Safety Instructions

Be sure to follow all warnings and instructions marked on the printer.
Use only the type of power source indicated on the printer's label.

Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do
not use the cord with any other equipment.

Make sure the AC power cord meets the relevant local safety standard.
Place the printer near a wall outlet where the plug can be easily unplugged.

Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that
regularly switches on and off, or on an outlet controlled by a wall switch or timer.

Do not let the power cord become damaged or frayed.

If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged
into the extension cord does not exceed the cord’'s ampere rating. Also, make sure the total ampere
rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.
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Always turn off the printer using the power button, and wait until the power light stops flashing before
unplugging the printer or cutting off power to the electrical outlet.

Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

Keep your product at least 8.7 inches (22 cm) away from cardiac pacemakers to prevent your
product's radio waves from affecting the operation of the pacemaker.

Leave enough space in front of the printer for the paper to be fully ejected.
Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
Do not place the printer near a radiator or heating vent or in direct sunlight.

Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the
case or insert objects through the slots.

Keep the printer away from potential sources of electromagnetic interference, such as loudspeakers or
the base units of cordless telephones.

Do not put your hand inside the printer while it is printing.

Do not touch the flat white cable inside the printer.

Do not move the print head by hand; this may damage the printer.

Do not spill liquid on the printer and do not handle the printer with wet hands.

Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may
cause fire.

Except as specifically explained in your documentation, do not attempt to service the printer yourself.

Unplug the printer and refer servicing to qualified service personnel under the following conditions: if
the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in
the plug, make sure you replace them with fuses of the correct size and rating.

Before transporting the printer, make sure that the print head is in the home (far right) position.

When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down;
otherwise, ink may leak.

Parent topic: Important Safety Instructions
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Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices

186



Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6,that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way,
Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAlLegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.

1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.
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1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling
1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a
single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the
selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not
any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising
out of or relating to the interpretation, applicability, enforceability or formation of this Agreement,
including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad
delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or
cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1
above. The arbitrator shall be empowered to grant whatever relief would be available in a court under
law or in equity. The arbitrator may award you the same damages as a court could, and may award
declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent
necessary to provide relief warranted by that party's individual claim. In some instances, the costs of
arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration
than in court. The arbitrator's award is binding and may be entered as a judgment in any court of
competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:

(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.
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(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.

1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).
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1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.
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Trademarks

EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson
Connect™ is a trademark of Seiko Epson Corporation.

Epson Store®™ is a service mark of Epson America, Inc.
Epson iPrint™ and Remote Print™ are trademarks of Seiko Epson Corporation.
Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Apple, App Store, Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other
countries.

Google® is a registered trademark and Android™, Chromebook™, Gmail™, Google Chrome™, Google
Cloud Print™, Google Drive™, and Google Play™ are trademarks of Google LLC.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.

General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON

EXCEED YOUR VISION
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Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
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Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution
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A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
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Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.
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Copyright Attribution
© 2019 Epson America, Inc.
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